USER'S MANUAL
Notice

The company reserves the right to revise this publication or to change its contents without notice. Information contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear in this publication nor are they in any way responsible for any loss or damage resulting from the use (or misuse) of this publication.

This publication and any accompanying software may not, in whole or in part, be reproduced, translated, transmitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators of this publication, except for copies kept by the user for backup purposes.

Brand and product names mentioned in this publication may or may not be copyrights and/or registered trademarks of their respective companies. They are mentioned for identification purposes only and are not intended as an endorsement of that product or its manufacturer.

©August 2005

Trademarks

This product incorporates copyright protection technology that is protected by method claims of certain U.S. patents and other intellectual property rights owned by Macrovision Corporation and other rights owners. Use of this copyright protection technology must be authorized by Macrovision Corporation, and is intended for home or other limited viewing uses only unless otherwise authorized by Macrovision Corporation. Reverse engineering or disassembly is prohibited.

Intel®, Pentium® and Celeron® are US registered trademarks of Intel Corporation.

SRS (Wow) is a trademark of SRS Labs, Inc.

WOW technology is incorporated under license from SRS Labs, Inc.
FCC Statement
(Federal Communications Commission)
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in accordance with the instructions, may cause harmful interference to radio communications. However, there is no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful interference to radio or television reception, which can be determined by turning the equipment off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

- Re orient or relocate the receiving antenna.
- Increase the separation between the equipment and receiver.
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
- Consult the service representative or an experienced radio/TV technician for help.

Warning
Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not expressly approved by the manufacturer for compliance with the above standards could void your authority to operate the equipment.
IMPORTANT SAFETY INSTRUCTIONS

Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet basement or near a swimming pool.
2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There may be a remote risk of electrical shock from lightning.
3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit (Model A by a DC Output 20V, 4.5A minimum AC/DC Adapter and Model B by a DC Output 20V, 6.0A minimum AC/DC Adapter - see pages 1 - 3 & C - 6).

CAUTION

Always disconnect all telephone lines from the wall outlet before servicing or disassembling this equipment.

TO REDUCE THE RISK OF FIRE, USE ONLY NO. 26 AWG OR LARGER, TELECOMMUNICATION LINE CORD

This Computer’s Optical Device is a Laser Class I Product
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. **Don't drop it, or expose it to shock.** If the computer falls, the case and the components could be damaged.

   - Do not expose the computer to any shock or vibration.
   - Do not place it on an unstable surface.
   - Do not place anything heavy on the computer.

2. **Keep it dry, and don't overheat it.** Keep the computer and power supply away from any kind of heating element. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly damaged.

   - Do not expose it to excessive heat or direct sunlight.
   - Do not leave it in a place where foreign matter or moisture may affect the system.
   - Don't use or store the computer in a humid environment.
   - Do not place the computer on any surface that will block the Vents/Fan Intakes.
3. **Avoid interference.** Keep the computer away from high capacity transformers, electric motors, and other strong magnetic fields. These can hinder proper performance and damage your data.

4. **Follow the proper working procedures for the computer.** Shut the computer down properly and don’t forget to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. **Take care when using peripheral devices.**
Power Safety
The computer has specific power requirements:

- Only use a power adapter approved for use with this computer.
- Your AC/DC adapter may be designed for international travel but it still requires a steady, uninterrupted power supply. If you are unsure of your local power specifications, consult your service representative or local power company.
- The power adapter may have either a 2-prong or a 3-prong grounded plug. The third prong is an important safety feature; do not defeat its purpose. If you do not have access to a compatible outlet, have a qualified electrician install one.
- When you want to unplug the power cord, be sure to disconnect it by the plug head, not by its wire.
- Make sure the socket and any extension cord(s) you use can support the total current load of all the connected devices.
- Before cleaning the computer, make sure it is disconnected from any external power supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power cord if you are wet.

Do not use the power cord if it is broken.

Do not place heavy objects on the power cord.
Battery Precautions

• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qualified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.

Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life, under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the manufacturer. Discard used battery according to the manufacturer’s instructions.
Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth.
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the power supply. Then refer servicing to qualified service personnel under any of the following conditions:

- When the power cord or AC/DC adapter is damaged or frayed.
- If the computer has been exposed to rain or other liquids.
- If the computer does not work normally when you follow the operating instructions.
- If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
- If there is an unusual odor, heat or smoke coming from your computer.

Removal Warning
When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it's latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag.
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both hardware and software. Make sure your “papers” are handy.

Power Off Before Traveling
Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vents/Fan Intakes to be blocked. To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intakes while the computer is in use.
**Preface**

**On the Road**

In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting, keep these points in mind:

**Hand-carry the notebook** - For security, don’t let it out of your sight. In some areas, computer theft is very common. Don’t check it with “normal” luggage. Baggage handlers may not be sufficiently careful. Avoid knocking the computer against hard objects.

**Beware of Electromagnetic fields** - Devices such as metal detectors & X-ray machines can damage the computer, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). **Note:** Some airports also scan luggage with these devices.

**Fly safely** - Most airlines have regulations about the use of computers and other electronic devices in flight. These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

**Get power where you can** - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies) charged.

**Keep it dry** - If you move quickly from a cold to a warm location, water vapor can condense inside the computer. Wait a few minutes before turning it on so that any moisture can evaporate.
Developing Good Work Habits

Developing good work habits is important if you need to work in front of the computer for long periods of time. Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or other joints. The following are some tips to reduce the strain:

- Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level of your elbow. Keep your forearms, wrists, and hands in a relaxed position.
- Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a footrest if necessary.
- Use a chair with a back and adjust it to support your lower back comfortably.
- Sit straight so that your knees, hips and elbows form approximately 90-degree angles when you are working.
- Take periodic breaks if you are using the computer for long periods of time.

Remember to:
- Alter your posture frequently.
- Stretch and exercise your body several times a day.
- Take periodic breaks when you work at the computer for long periods of time. Frequent and short breaks are better than fewer and longer breaks.
Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and shoulders.

- Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
- Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
- Position the display directly in front of you at a comfortable viewing distance.
- Adjust the display-viewing angle to find the best position.
Preface

Contents

Notice ................................................................. I
FCC Statement .................................................... II
Instructions for Care and Operation ..................... IV
Power Safety ....................................................... VI
Battery Precautions .......................................... VII
Cleaning .......................................................... VIII
Servicing .......................................................... VIII
Travel Considerations ....................................... IX

Quick Start Guide
Overview ......................................................... 1-1
Model Differences ............................................. 1-2
Advanced Users ................................................. 1-4
Beginners and Not-So-Advanced Users ............... 1-4
Warning Boxes ................................................ 1-4
Not Included ..................................................... 1-5
System Software ............................................... 1-5
System Startup .................................................. 1-6
System Map: Model A - Front View
with LCD Panel Open ....................................... 1-7
System Map: Model B - Front View
with LCD Panel Open ....................................... 1-8
LED Indicators .................................................. 1-9
Ap-Key Buttons & Keyboard ............................... 1-10
Function Keys .................................................. 1-11
System Map: Front View (Audio "DJ") ............... 1-12
Audio "DJ" CD Player ....................................... 1-13
System Map: Rear View .................................. 1-14
System Map: Right View .................................. 1-15
System Map: Left View ...................................... 1-16
System Map: Bottom View ............................... 1-17
Windows XP Start Menu & Control Panel .......... 1-18
Video Features .................................................. 1-19
Display Devices & Options ............................... 1-21
Power Management Features ......................... 1-22

Features & Components
Overview ......................................................... 2-1
Hard Disk Drive ............................................... 2-2
Optical (CD/DVD) Device ................................. 2-3
Loading Discs ................................................ 2-3
Handling CDs or DVDs ..................................... 2-4
DVD Regional Codes ....................................... 2-5
4-in-1 Card Reader .......................................... 2-6
PC Card Slot .................................................. 2-7
Inserting and Removing PC Cards .................... 2-7
# Preface

Auto Mail Checker ................................................... 2-8  
Application Ap-Key ............................................... 2-10  
TouchPad and Buttons/Mouse ............................... 2-11  
  Configuring the TouchPad and Buttons .............. 2-11  
Audio Features ....................................................... 2-12  
Adding a Printer ..................................................... 2-13  
  USB Printer ......................................................... 2-13  
  Parallel Printer ..................................................... 2-13  

## Power Management

Overview ................................................................. 3-1  
  Advanced Configuration and Power Interface .... 3-1  
The Power Sources ................................................... 3-2  
  AC/DC Adapter ...................................................... 3-2  
  Battery ................................................................... 3-2  
Turning on the Computer ......................................... 3-3  
Power Schemes ......................................................... 3-4  
System Power Options ............................................. 3-6  
  Hibernate Mode vs. Shutdown ......................... 3-6  
  Standby Mode vs. Hibernate Mode .................. 3-6  
  Standby .............................................................. 3-7  
  Hibernate ............................................................ 3-7  
Configuring the Power Button ................................ 3-8  
Battery Information ................................................. 3-9  
  New Battery ........................................................ 3-9  

Battery Life .................................................................. 3-9  
Recharging the Battery with the AC/DC Adapter 3-10  
Proper handling of the Battery Pack ................... 3-11  
Battery FAQ ........................................................ 3-12  

## Drivers & Utilities

What to Install .......................................................... 4-1  
  Module Driver Installation ................................ 4-1  
Service Packs .......................................................... 4-3  
Authorized Driver Message .................................. 4-4  
Version Conflict Message ...................................... 4-4  
Updating/Reinstalling Individual Drivers .............. 4-4  
Driver Installation .................................................... 4-5  
  Driver Installation Procedure ......................... 4-6  
  New Hardware Found ........................................ 4-6  
Service Pack Installation ...................................... 4-6  
  Chipset ............................................................... 4-7  
  Video(VGA) ......................................................... 4-7  
  Audio ................................................................. 4-8  
  Modem ............................................................... 4-8  
  LAN ................................................................. 4-9  
  AP-Key Buttons .................................................. 4-9  
  TouchPad .......................................................... 4-10  
PCMCIA/Card Reader ............................................. 4-10  
AutoMail .......................................................... 4-11
Module Drivers ....................................................4-11
Wireless LAN .....................................................4-11
Bluetooth .............................................................4-11
PC Camera ..........................................................4-11
TV Tuner Options ...............................................4-11

BIOS Utilities
Overview ..................................................................5-1
The Power-On Self Test (POST) .........................5-2
Failing the POST ....................................................5-3
Fatal Errors ............................................................5-3
Non-Fatal Errors ....................................................5-3
The Setup Program ...................................................5-4
Entering Setup ........................................................5-4
Setup Screens .........................................................5-5
Main Menu ...............................................................5-6
System Time & Date (Main Menu) ..................5-6
IDE Channel 0 Master/Slave (Main Menu) ..........5-7
SATA Port 1/Main Menu) .................................5-7
System/Extended Memory: (Main Menu) ..........5-7
VGA BIOS Revision: (Main Menu) .................5-7
Advanced Menu .......................................................5-8
Advanced Chipset Control (Advanced Menu) ......5-8
National 383 SIO Control
Sub-Menu (Advanced Menu) .............................5-9
Legacy USB Support (Advanced Menu) ..........5-9
Boot-time Diagnostic Screen: (Advanced Menu) .....5-9
Reset Configuration Data: (Advanced Menu) ......5-9
Power on Boot Beep/Battery
Low Alarm Beep: (Advanced Menu) .................5-9
Security Menu .......................................................5-10
Set Supervisor Password (Security Menu) .......5-10
Password on boot: (Security Menu) ................5-11
Boot Menu ..............................................................5-12
Configuring the Network Boot Protocol ..........5-14
Exit Menu ...............................................................5-15

Upgrading The Computer
Overview .............................................................6-1
When Not to Upgrade ............................................6-2
Removing the Battery ..............................................6-3
Upgrading the Hard Disk Drive ...........................6-4
Upgrading the Optical (CD/DVD) Device ..........6-7
Upgrading the System Memory (RAM) ..............6-8
Inserting the 2nd Hard Disk .................................6-11
Upgrading the Processor .................................6-12

Modules & Options
Overview .............................................................7-1
Preface

Intel PRO/Wireless Mini-PCI WLAN Module ....7-2
Intel WLAN Driver Installation ......................7-3
Bluetooth Module ........................................7-4
Bluetooth Driver Installation .......................7-4
Bluetooth Audio Setup ................................7-6
PC Camera Module ........................................7-8
Sertek PC Camera Driver Installation (WinXP) ..7-9
PC Camera Audio Setup ................................7-10
BisonCap .....................................................7-12
Eliminating Screen Flicker ...........................7-13
TV Tuner Module Options .............................7-14
LifeView FlyDVB-T Hybrid Mini-PCI
TV Tuner Module .........................................7-15
Installing the LifeView FlyDVB-T Driver ........7-15
Installing the InterVideo WinDVD 4 Software ..7-15
YUAN PVR Mini-PCI MPC622-MCE
TV Tuner Module .........................................7-16
Installing the MPC622 Driver for
Windows XP Media Center Edition (MCE) ......7-16

Troubleshooting
Overview .......................................................8-1
Basic Hints and Tips .....................................8-2
Backup and General Maintenance ..................8-3
Viruses .......................................................8-4
Upgrading and Adding New Hardware/Software ...8-5
Problems and Solutions ..................................8-7

Interface (Ports & Jacks)
Overview .....................................................A-1
Notebook Ports and Jacks ..............................A-2
Built-In Microphone ....................................A-2
Card Reader Port .........................................A-2
CATV-In Jack ..............................................A-2
DVI-Out Port ...............................................A-2
DC-In Jack ..................................................A-2
Headphone-Out Jack ....................................A-2
Line-In Jack ................................................A-3
Microphone-In Jack .....................................A-3
Mini-IEEE 1394 Port ....................................A-3
RJ-11 Phone Jack .......................................A-3
RJ-45 LAN Jack ..........................................A-3
Security Lock Slot .......................................A-4
Serial Port ...............................................A-4
S/PDIF-Out Jack .........................................A-4
S-Video-Out Jack .......................................A-4
USB 2.0/1.1 Ports .......................................A-4
Preface

ATI Video Driver Controls
ATI Video Driver Installation ......................... B-1
ATI Mobility Radeon Properties ...................... B-2
Display Devices .............................................. B-4
Attaching Other Displays ............................... B-5
Display Modes ................................................. B-6
  Clone Mode ................................................ B-7
Enabling TV Display ....................................... B-11

Specifications
Processor ....................................................... C-2
Core Logic ...................................................... C-2
Memory ........................................................ C-2
Security ......................................................... C-2
BIOS ............................................................ C-2
LCD ............................................................. C-2
Video Card Options ....................................... C-3
Storage ........................................................ C-4
Audio .......................................................... C-4
Interface & Communication .......................... C-5
Card Reader .................................................. C-5
Keyboard & Pointing Device ......................... C-6
PCMCIA ........................................................ C-6
Power Management ...................................... C-6
Power ........................................................... C-6
Environmental Spec ..................................... C-6
Physical Dimensions & Weight ....................... C-6
Optional ....................................................... C-7
Chapter 1: Quick Start Guide

Overview

This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2  A guide to using some of the main features of the computer e.g. the storage devices (hard disk, optical device, 4-in-1 card reader, PC Card), Auto Mail Checker, Touch Pad & Mouse, Audio Features & Printer.
• Chapter 3  The computer’s power saving options.
• Chapter 4  The installation of the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems.
• Chapter 5  An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6  Instructions for upgrading your computer.
• Chapter 7  A quick guide to the computer’s Wireless LAN, Bluetooth, PC Camera and TV Tuner modules (some of which may be optional depending on your purchase configuration).
• Chapter 8  A troubleshooting guide.
• Appendix A  Definitions of the interface, ports/jacks which allow your computer to communicate with external devices.
• Appendix B  Information on the ATI Video driver controls.
• Appendix C  The computer’s specification.
Model Differences
This notebook series includes two different model types. The models differ slightly in design style including the LCD type, and AC/DC adapter. See Figure 1 - 1 below and Table 1 - 1, on page 1 - 3 for an outline of the model differences (Model B includes two different design types).
### Table 1 - 1 - Model Differences

<table>
<thead>
<tr>
<th>Feature</th>
<th>Model A</th>
<th>Model B</th>
</tr>
</thead>
<tbody>
<tr>
<td>Processor Options</td>
<td>Pentium M &amp; Celeron M Processor Options</td>
<td>Pentium M Processor Options Only</td>
</tr>
<tr>
<td>(See Page C - 2)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Design Types</td>
<td>1 * Design Type</td>
<td>2 * Design Types</td>
</tr>
<tr>
<td>LCD Type</td>
<td>15.4&quot; WXGA (1440*900) Flat Panel TFT OR</td>
<td>17.0&quot; WXGA (1440*900) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>15.4&quot; WSXGA+ (1680*1050) Flat Panel TFT OR</td>
<td>17.0&quot; WSXGA+ (1680*1050) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>15.4&quot; WUXGA (1920*1200) Flat Panel TFT</td>
<td>17.0&quot; WUXGA (1900*1200) Glare Type Flat Panel TFT</td>
</tr>
<tr>
<td>Video Card</td>
<td>ATI X700 (M26) PCI Express Video Card (128/256 MB DDR Video RAM On Board)</td>
<td>ATI X700 (M26) PCI Express Video Card (128 MB DDR Video RAM On Board) OR ATI X800 XT (M28 PRO) PCI Express Video Card</td>
</tr>
<tr>
<td>AC/DC Adapter</td>
<td>Full Range AC/DC Adapter 20V, 4.5A (90 Watts), 100<del>240V, 47</del>63Hz</td>
<td>Full Range AC/DC Adapter 20V, 6.0A (120 Watts), 100<del>240V, 47</del>63Hz</td>
</tr>
</tbody>
</table>
Quick Start Guide

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on page 6 - 1 in the User’s Manual. You may also find the notes marked with a ☰ of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then the information contained in this Quick Start Guide should be enough to get you up and running. Eventually you should try to look through all the documentation (more detailed descriptions of the functions, setup and system controls are covered in the remainder of the User’s Manual), but do not worry if you do not understand everything the first time. Keep this manual nearby and refer to it to learn as you go. You may find it useful to refer to the notes marked with a ☰ as indicated in the margin. For a more detailed description of any of the interface ports and jacks see “Interface (Ports & Jacks)” on page A - 1.

Notes
Check the light colored boxes with the mark above to find detailed information about the computer’s features.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the ☭ symbol. Also please note the safety and handling instructions as indicated in the Preface.
Not Included
Operating Systems (e.g. Windows XP) and applications (e.g. word processing, spreadsheet and database programs) have their own manuals, so please consult the appropriate manuals.

System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you are re-configuring your computer for a different system, you will find this manual refers to the Microsoft Windows XP (Home & Professional Editions) / Windows XP Media Center Edition operating system.

Drivers
If you are installing new system software, or are re-configuring your computer for a different system, you will need to install the drivers listed in “Drivers & Utilities” on page 4-1. Drivers are programs which act as an interface between the computer and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order listed in Table 4-1, on page 4-6. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If your system hasn’t been properly configured (your service representative may have already done that for you), refer to “Driver Installation Procedure” on page 4-6 for installation instructions.
Quick Start Guide

System Startup

1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack at the rear of the computer, then plug the AC power cord into an outlet, and connect the AC power cord to the AC/DC adapter.
5. Move the LCD latches (one Model B design does not have latches) at the front of the computer outwards towards the sides of the computer, and hold them in place to release the top cover.
6. Raise the lid/LCD to a comfortable viewing angle, and press the power button (make sure the Audio "DJ" player is turned off) to turn the computer “on”.
7. Adjust the LCD panel to a comfortable viewing angle.
8. The LED indicators show the power and battery status of the computer, give notification of e-mail received, and display information on the power status of the PC Camera, Bluetooth and Wireless LAN modules.

Shutdown

Please note that you should always shut your computer down by choosing the Turn Off Computer command from the Start menu in Windows. This will help prevent hard disk or system problems.
System Map: Model A - Front View with LCD Panel Open

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination (see Table 1 - 4, on page 1 - 11) to toggle power to any wireless modules, and check the LED indicators to see if any modules are powered on or not (see Table 1 - 2, on page 1 - 9).

Audio "DJ" & Power Button

Make sure that the Audio “DJ” player is off before pressing the power button to turn the computer on.

Audio "DJ" Controls

Built-In Microphone

Audio "DJ" LED Display Panel (Including LED Indicators)

Power Button

Keyboard

TouchPad and Buttons

Figure 1 - 2
Front View - LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Ap-Key Buttons
4. Power Button
5. Keyboard
6. TouchPad and Buttons
7. Audio "DJ" Controls
8. Built-In Microphone
9. Audio "DJ" LED Display Panel (Including LED Indicators)
System Map: Model B - Front View with LCD Panel Open

Figure 1 - 3
Front View - LCD Panel Open

1. Optional Built-In PC Camera
2. LCD
3. Ap-Key Buttons
4. Power Button
5. Keyboard
6. TouchPad and Buttons
7. Audio "DJ" Controls
8. Built-In Microphone
9. Audio "DJ" LED Display Panel (Including LED Indicators)

Audio "DJ" & Power Button
Make sure that the Audio "DJ" player is off before pressing the power button to turn the computer on.

Wireless Device Operation Aboard Aircraft
The use of any portable electronic transmission devices (e.g. WLAN or Bluetooth) aboard aircraft is usually prohibited. Make sure any wireless modules are OFF if you are using the computer aboard aircraft.

Use the appropriate function key combination (see Table 1 - 4, on page 1 - 11) to toggle power to any wireless modules, and check the LED indicators to see if any modules are powered on or not (see Table 1 - 2, on page 1 - 9).
LED Indicators

The LED indicators on the computer display helpful information about the current status of the computer.

Table 1 - 2 - LED Indicators

<table>
<thead>
<tr>
<th>Icon</th>
<th>Color</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>☀</td>
<td>Green</td>
<td>The Computer is On</td>
</tr>
<tr>
<td>☀ Blinking Green</td>
<td>The Computer is In Standby Mode</td>
<td></td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>The AC/DC Adapter is Plugged In</td>
</tr>
<tr>
<td>🔒</td>
<td>Green</td>
<td>Number Lock is Activated (to activate press Fn &amp; NumLk)</td>
</tr>
<tr>
<td>🔒</td>
<td>Green</td>
<td>Caps Lock is Activated</td>
</tr>
<tr>
<td>🔒</td>
<td>Green</td>
<td>Scroll Lock is Activated (to activate press Fn &amp; ScrLk)</td>
</tr>
<tr>
<td>🔋</td>
<td>Orange Blinking</td>
<td>The Battery is Charging</td>
</tr>
<tr>
<td>🔋</td>
<td>Orange Blinking</td>
<td>The Battery has Reached Critically Low Power Status</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>The Battery is Fully Charged</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>Second Battery Indicator (Colors Displayed as Above)</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>Hard Disk Activity</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>The PC Camera Module is Powered On</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>The Bluetooth Module is Powered On</td>
</tr>
<tr>
<td>🔋</td>
<td>Green</td>
<td>The WLAN Module is Powered On</td>
</tr>
<tr>
<td>🔋</td>
<td>Blinking Amber</td>
<td>New Mail Has Arrived</td>
</tr>
</tbody>
</table>
Quick Start Guide

Ap-Key Buttons & Keyboard

These buttons give instant access to the default Internet browser and e-mail program, and to a user-defined application, with one quick button press. To use the “user-defined application Ap-Key Button”, you must install the driver (see “AP-Key Buttons” on page 4-9). See “Application Ap-Key” on page 2-10 for configuration instructions.

Table 1-3 - Ap-Key Buttons

<table>
<thead>
<tr>
<th>Ap-Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>🌐</td>
<td>Activate the user specified application e.g. Microsoft Word or Excel</td>
</tr>
<tr>
<td>🌐</td>
<td>Activate the Default Internet Program</td>
</tr>
<tr>
<td>🌐</td>
<td>Activate the Default E-Mail Browser</td>
</tr>
</tbody>
</table>

The keyboard has an embedded numerical keypad for easy numeric data input, and features Function Keys to allow you to change operational features instantly (see Figure 1-4). Model A’s keyboard is pictured below. Model B includes a numeric keypad on the right.

Figure 1 - 4 - Keyboard

Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will detect and enable it automatically. However special functions/Ap-keys unique to the system’s regular keyboard may not work.

1 - 10 Ap-Key Buttons & Keyboard
Function Keys

To use the function keys, press and hold the \textbf{Fn} key, then press the appropriate function key (F3 - F12 etc.).

<table>
<thead>
<tr>
<th>Key</th>
<th>Function</th>
<th>Key</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fn</td>
<td>Function Key</td>
<td>Fn + F9</td>
<td>Increase LCD Brightness</td>
</tr>
<tr>
<td>Fn + F3</td>
<td>Mute Toggle</td>
<td>Fn + F10</td>
<td>PC Camera Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F4</td>
<td>Sleep Toggle</td>
<td>Fn + F11</td>
<td>Wireless LAN Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F5</td>
<td>Decrease Audio Volume</td>
<td>Fn + F12</td>
<td>Bluetooth Module Power Toggle</td>
</tr>
<tr>
<td>Fn + F6</td>
<td>Increase Audio Volume</td>
<td>Fn + NumLk</td>
<td>Number Lock Toggle</td>
</tr>
<tr>
<td>Fn + F7</td>
<td>Display Toggle</td>
<td>Fn + ScrLk</td>
<td>Scroll Lock Toggle</td>
</tr>
<tr>
<td>Fn + F8</td>
<td>Decrease LCD Brightness</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

\textit{Table 1 - 4 - Function Keys}

\textbf{Special Characters}

Some software applications allow the number-keys to be used with \textbf{Alt} to produce special characters. These special characters can only be produced by using the numeric keypad. Regular number keys (in the upper row of the keyboard) will not work. Make sure that \textbf{NumLk} is on.
Quick Start Guide

System Map: Front View (Audio "DJ")

1. Audio "DJ" Power Button
2. Volume Down
3. Volume Up
4. Repeat
5. LED Display
6. Previous Track
7. Next Track
8. Play/Pause
9. Stop (Press Twice To Eject The CD/DVD)
10. Repeat Mode Indicator
11. Track Indicator
12. Time Indicator
13. Disc Indicator

Audio "DJ" MP3 Track Limit
There is a track limit of 256 tracks on any MP3 CD/DVD. This means that only the first 256 tracks may be played on any MP3 DC/DVD.

Audio "DJ" & Power Button
Make sure that the Audio "DJ" player is off before pressing the power button to turn the computer on.
Audio "DJ" CD Player

The built-in standalone audio CD player gives direct hardware control for audio CDs/DVDs when the computer is shut down, but has a working power source.

1. Make sure that the computer is shut down (i.e. the operating system is not running) but you have a working power source (either battery or AC Power).
2. Press the Audio "DJ" power button.
3. Press the open button on your CD/DVD device (or press the stop button twice) and carefully place an audio CD onto the disc tray with label-side facing up (DVD drives will also play audio CDs).
4. Gently push the CD/DVD tray in until its lock "clicks" and you are ready to start.
5. The Disc Indicator will flash while data is being accessed.
6. The LED will display the number of tracks.
7. Press the play/pause button to start the CD/DVD.
8. Control the CD/DVD tracking and volume from the control panel.
9. Use the stop button to stop the disc, or press it twice to eject the disk.
10. Press the power button again to turn the player off.

TV Tuner Option

If you have included the optional TV Tuner in your purchase configuration, you can use the supplied remote control unit to control the Audio "DJ".

Disk Eject Warning

Don’t try to eject a CD/DVD while the system is accessing it. This may cause the system to “crash”. Stop the disk first then eject it, or press the stop button twice.
System Map: Rear View

1. Vent/Fan Intake/Outlet
2. S/PDIF-Out Jack
3. Line-In Jack
4. 2 * USB 2.0 Ports
5. DVI-Out Port
6. CATV Jack (Enabled With TV Tuner Only)
7. RJ-11 Phone Jack
8. RJ-45 LAN Jack
9. S-Video-Out Jack
10. DC-In Jack
11. Serial Port

Overheating
To prevent your computer from overheating make sure nothing blocks the Vent/Fan Intake/Outlet while the computer is in use.
4-in-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:
- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)

Mini-IEEE 1394a Port

Both Mini-IEEE 1394a ports only support SELF POWERED IEEE 1394a devices.
Quick Start Guide

System Map: Left View

*Figure 1 - 8 - Left View*

1. Security Lock Slot
2. Speaker
3. Optional Device Drive Bay
   (for CD/DVD Device - see page 2 - 3, or 2nd PATA Hard Disk, or 2nd Battery)

---

**CD/DVD Emergency Eject**

If you need to manually eject a CD/DVD (e.g. due to an unexpected power interruption) you may push the end of a straightened paper clip into the emergency eject hole. Do not use a sharpened pencil or similar object that may break and become lodged in the hole.

**Media Warning**

Don’t try to remove a floppy disk/CD/DVD while the system is accessing it. This may cause the system to “crash”.

---

**Changing DVD Regional Codes**

Go to the Control Panel and double-click System > Hardware (tab), click Device Manager, then click the + next to DVD/CD-ROM drives. Double-click on the DVD-ROM device to bring up the Properties dialogue box, and select the DVD Region (tab) to bring up the control panel to allow you to adjust the regional code (see “DVD Regional Codes” on page 2 - 5).

DVD region detection is device dependent, not OS-dependent. You can select your module’s region code 5 times. The fifth selection is permanent. This cannot be altered even if you change your operating system or you use the module in another computer.
**System Map: Bottom View**

- **Model A**
  1. Vent/Fan Intake/Outlet
  2. Video Card Cover (Model A)
  3. Battery
  4. Optical Device Release Latches
  5. HDD / RAM Bay Cover (Model A)
  6. Video Card / HDD / RAM Bay Cover (Model B)
  7. Infrared & Consumer Infrared Transceiver

- **Model B**
  1. Vent/Fan Intake/Outlet
  2. Video Card Cover (Model A)
  3. Battery
  4. Optical Device Release Latches
  5. HDD / RAM Bay Cover (Model A)
  6. Video Card / HDD / RAM Bay Cover (Model B)
  7. Infrared & Consumer Infrared Transceiver

---

**Battery Information**

Always completely discharge, then fully charge, a new battery before using it. Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges. See “Battery Information” on page 3 - 9 for full instructions.

---

**Figure 1 - 9 - Bottom View**

1. Vent/Fan Intake/Outlet
2. Video Card Cover (Model A)
3. Battery
4. Optical Device Release Latches
5. HDD / RAM Bay Cover (Model A)
6. Video Card / HDD / RAM Bay Cover (Model B)
7. Infrared & Consumer Infrared Transceiver
Quick Start Guide

Windows XP Start Menu & Control Panel

Most of the control panels, utilities and programs within Windows XP (and most other Windows versions) are accessed from the Start menu. When you install programs and utilities they will be installed on your hard disk drive, and a shortcut will usually be placed in the Start menu and/or the desktop. You can customize the look of the Start menu by right-clicking the Start menu and selecting Properties from the menu.

In many instances throughout this manual you will see an instruction to open the Control Panel. The Control Panel is accessed from the Start menu, and it allows you to configure the settings for most of the key features in Windows (e.g. power, video, network, audio etc.). Windows XP provides basic controls for many of the features, however many new controls are added (or existing ones are enhanced) when you install the drivers listed in Table 4 - 1, on page 4 - 6. To see all controls it may be necessary to toggle off Category View.
Video Features

This computer features Two different PCI Express video cards, depending on the model purchased (see “Video Card Options” on page C - 3). Model A computers feature an ATI Mobility Radeon X700 (M26) video card with 128/256MB DDR video RAM on board; Model B computers feature either an ATI Mobility Radeon X700 (M26) video card with 128MB DDR video RAM on board, or an ATI Mobility Radeon X800 XT (M28 PRO) video card. You can switch display devices, and configure display options, from the Display Properties control panel in Windows as long as the appropriate video driver is installed. For more detailed video information see “ATI Video Driver Controls” on page B - 1.

To access Display Properties in Windows:

1. Click Start, point to Settings and click Control Panel (or just click Control Panel).
2. Double-click Display (icon) - In the Appearances and Themes category.
3. Click Settings (tab) in the Display Properties dialog box.
4. Move the slider to the preferred setting in Screen area/resolution (Figure 1 - 11 on page 1 - 20).
5. Click the arrow, and scroll to the preferred setting In Colors/Color quality (Figure 1 - 11 on page 1 - 20).
6. You can also access Display Properties by right-clicking the desktop and scrolling down and clicking Properties. Click Settings (tab) and adjust as above.
7. Open the Display Properties control panel, and click Advanced (button) (Figure 1 - 11 on page 1 - 20) to bring up the Advanced properties tabs.
8. Clicking through the ATI tabs allows you to make any video adjustments you require.
ATI Mobility Radeon Properties

The pictures used in Figure 1 - 11 are taken from the ATI Mobility Radeon X700 properties tabs. If your purchase option includes the ATI Mobility Radeon X800 XT video card, then the properties tabs may appear slightly different.
Display Devices & Options
Besides the built-in LCD, you can also use an external VGA monitor (CRT)/external Flat Panel Display or TV as your display device. A VGA monitor/Flat Panel Display connects to the DVI-Out port, a TV to the S-Video-Out jack. The following display modes are available (see “ATI Video Driver Controls” on page B - 1 for full details).

<table>
<thead>
<tr>
<th>ATI Display Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Single</td>
<td>One of the connected displays is used as the display device</td>
</tr>
<tr>
<td>Multiple - Clone Mode</td>
<td>Both connected displays output the same view</td>
</tr>
<tr>
<td>Multiple - Extended Desktop Mode</td>
<td>Both connected displays are treated as separate devices, and act as a virtual desktop</td>
</tr>
</tbody>
</table>

*Table 1 - 5 - Display Options*

Note: Model B computers with ATI Mobility Radeon X800 XT video cards also support HDTV output, but require an HDTV converter (contact your service center for the HDTV converter) connected to the S-Video-Out port.
Quick Start Guide

Power Management Features

The Power Options control panel icon in Windows (see page 1 - 18) allows you to configure power management features for your computer. You may conserve power through individual components such as the monitor or hard disk (by means of Power Schemes), or you may use either Standby or Hibernate mode to conserve power throughout the system (enable Hibernate support from the control panel as pictured in Figure 1 - 12). Pay attention to the instructions on battery care in “Battery Information” on page 3 - 9.

The computer’s power button, sleep button (Fn + F4 key combination), and lid (closing the lid) may be set to send the computer in to either Standby or Hibernate mode.

Power Saving and Performance
Power Schemes may have an affect on your computer performance (see “Power Schemes” on page 3 - 4).
Chapter 2: Features & Components

Overview

Read this chapter to learn more about the following main features and components of the computer:

- Hard Disk Drive
- Optical (CD/DVD) Device
- 4-in-1 Card Reader
- PC Card Slot
- Auto Mail Checker
- Application Ap-Key
- TouchPad and Buttons/Mouse
- Audio Features
- Adding a Printer
Hard Disk Drive

The hard disk drive is used to store your data in the computer. The hard disk can be taken out to accommodate other 2.5” serial (SATA) hard disk drives with a height of 9.5 mm.

The hard disk is accessible from the bottom of your computer as seen below. For further details see “Upgrading the Hard Disk Drive” on page 6 - 4.

Power Safety

Before attempting to access any of the internal components of your computer please ensure that the machine is not connected to the AC power, and that the machine is turned off. Also ensure that all peripheral cables, including phone lines, are disconnected from the computer.

Figure 2 - 1

Hard Disk Location
Optical (CD/DVD) Device

There is a bay for a 5.25" optical (CD/DVD) device (12.7mm height). The actual device will depend on the module you purchased (see “Storage” on page C - 4). The optical device is usually labeled “Drive D:” and may be used as a boot device if properly set in the BIOS (see “Boot Menu” on page 5 - 12).

Loading Discs

To insert a CD/DVD, press the open button 1 and carefully place a CD/DVD onto the disc tray with label-side facing up (use just enough force for the disc to click onto the tray’s spindle). Gently push the CD/DVD tray in until its lock “clicks” and you are ready to start. The busy indicator 2 will light up while data is being accessed, or while an audio/video CD, or DVD, is playing. If power is unexpectedly interrupted, insert an object such as a straightened paper clip into the emergency eject hole 3 to open the tray.

Sound Volume Adjustment

How high the sound volume can be set depends on the setting of the volume control within Windows. Click the Volume icon on the taskbar to check the setting (see “Audio Features” on page 2 - 12).

Figure 2 - 2
Optical Device
Handling CDs or DVDs
Proper handling of your CDs/DVDs will prevent them from being damaged. Please follow the advice below to make sure that the data stored on your CDs/DVDs can be accessed.

Note the following:

- Hold the CD or DVD by the edges; do not touch the surface of the disc
- Use a clean, soft, dry cloth to remove dust or fingerprints
- Do not write on the surface with a pen
- Do not attach paper or other materials to the surface of the disc
- Do not store or place the CD or DVD in high-temperature areas
- Do not use benzene, thinner, or other cleaners to clean the CD or DVD
- Do not bend the CD or DVD
- Do not drop or subject the CD or DVD to shock
DVD Regional Codes
To change the DVD regional codes see “Changing DVD Regional Codes” on page 1 - 16.

<table>
<thead>
<tr>
<th>Region</th>
<th>Geographical Location</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>USA, Canada</td>
</tr>
<tr>
<td>2</td>
<td>Western Europe, Japan, South Africa, Middle East &amp; Egypt</td>
</tr>
<tr>
<td>3</td>
<td>South-East Asia, Taiwan, South Korea, The Philippines, Indonesia, Hong Kong</td>
</tr>
<tr>
<td>4</td>
<td>South &amp; Central America, Mexico, Australia, New Zealand</td>
</tr>
<tr>
<td>5</td>
<td>N Korea, Russia, Eastern Europe, India &amp; Most of Africa</td>
</tr>
<tr>
<td>6</td>
<td>China</td>
</tr>
</tbody>
</table>

Table 2 - 1
DVD Regional Coding

Figure 2 - 3
DVD Regions
Features & Components

4-in-1 Card Reader

The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device, and can be accessed in the same way as your hard disk(s). Make sure you install the PCMCIA/Card Reader Card driver (see “PCMCIA/Card Reader” on page 4 - 10).

- MMC (MultiMedia Card)
- SD (Secure Digital)
- MS (Memory Stick)
- MS Pro (Memory Stick Pro)

Card Reader Cover

Make sure you keep the cover in the card reader when not in use. This will help prevent foreign objects and/or dust getting into the card reader.

Figure 2 - 4
Right View

1. Card Reader

Model A (Right)

Model B (Right)
PC Card Slot

The computer is equipped with a PCMCIA 3.3V/5V slot for one type II PC-MCIA CardBus PC Card Slot. Make sure you install the PCMCIA/Card Reader Card driver (see “PCMCIA/Card Reader” on page 4 - 10).

Inserting and Removing PC Cards

- Align the PC Card with the slot and push it in until it locks into place.
- To remove a PC Card, simply press the eject button 1 next to the slot.

Model A (Right)

Model B (Right)
Auto Mail Checker

After you have installed the driver for the Auto Mail Checker program (see “AutoMail” on page 4-11) you may then configure it to give you notification when you receive new mail. You must be online to receive this notification (note that this program only supports the POP3 protocol), and your default mail program does not need to be open.

The Auto Mail Checker appears as an icon in the taskbar (if you do not see the icon in the taskbar go to Start > Programs/All Programs > Auto Mail Checker > Auto Mail Checker). Right clicking on the icon will bring up the following options menu. If you have not input your mail account data, then you will be prompted to do so.

Select Open to bring up the control panel for the program.
You may then configure the options for your mailserver, name, password, program and method(s) of notification.

Note

Check with your Internet Service Provider, network administrator or Mail Service provider for details on what to put on these pages.

Figure 2 - 7
Auto Mail Checker
Account Setup and Options
Application Ap-Key

The Ap-key buttons give instant access to the default Internet browser and e-mail program, and to a user-defined application, with one quick button press. To configure a program to open when the application Ap-key is pressed (Windows Media Player is the default program), follow the instructions below.

1. **Right click** the Ap-Key driver icon in the **taskbar**.
2. Select **Setup** from the menu, scroll to **Application 1** and press **Enter**.
3. An **Open** dialog box will appear on the screen.
4. **Browse** to the directory where the desired application.exe (see the sidebar) program exists.
5. **Double-Click** on the program file or choose **Open**.

![Figure 2 - 8 Ap-Key Configuration Screens](image)
TouchPad and Buttons/Mouse

The TouchPad is an alternative to the mouse; however, you can also add a mouse to your computer through one of the USB ports. The TouchPad buttons function in much the same way as a two-button mouse. The central button may be configured to function as you require.

Configuring the TouchPad and Buttons

Once you have installed the TouchPad driver you can configure the functions by double-clicking the TouchPad driver icon on the taskbar, or by going to the Mouse control panel in Windows (Start menu and point to Settings and click Control Panel, then double-click the Mouse icon). In Windows XP the Mouse control panel is in the Printers and Other Hardware Category.

Mouse Driver

If you are using an external mouse your operating system may be able to auto-configure your mouse during its installation or only enable its basic functions. Be sure to check the device’s user documentation for details.
Audio Features

You can configure the audio options on your computer from the Sounds and Audio Devices, Windows control panel, or from the Sound Effect Manager icon in the taskbar/control panel (this will bring up the Realtek Audio Configuration menus). The volume may also be adjusted by means of the Fn + F5/F6 key combination (see “Bluetooth Audio Setup” on page 7 - 6 and “PC Camera Audio Setup” on page 7 - 10 for further audio information).
Adding a Printer

The most commonly used peripheral is a printer. The following conventions will help you to add a printer, however it is always best to refer to the printer manual for specific instructions and configuration options.

USB Printer

Most current printers have a USB interface connection. You may use any one of the ports to connect the printer.

Install Instructions:
1. Set up the printer according to its instructions (unpacking, paper tray, toner/ink cartridge etc.).
2. Turn ON the computer.
3. Turn ON the printer.
4. Connect the printer’s USB cable to one of the USB ports on the computer.
5. Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.

Parallel Printer

This is still a very common type of printer, and requires the purchase of a parallel to USB converter in order to use it. The install instructions are in the sidebar.

Parallel Printer

After setting up the printer attach the parallel cable to the printer.

Connect the printer’s parallel cable to the Parallel to USB converter, and then plug the converter into the USB port.

Turn ON the printer, then turn ON the computer.

Windows will identify the printer and either load one of its own drivers or ask you to supply one. Follow the on-screen instructions.
Features & Components
Chapter 3: Power Management

Overview

To conserve power, especially when using the battery, your computer uses the ACPI power management system. Power management conserves power by controlling individual components of the computer (the monitor and hard disk drive) or the whole system. This chapter covers:

- The Power Sources
- Turning on the Computer
- Power Schemes
- System Power Options
- Configuring the Power Button
- Battery Information

Advanced Configuration and Power Interface

The ACPI interface provides the computer with enhanced power saving techniques and gives the operating system (OS) direct control over the power and thermal states of devices and processors. For example, it enables the OS to set devices into low-power states based on user settings and information from applications. ACPI is fully supported in Windows XP/Windows XP MCE.

OS Note

Power management functions will vary slightly depending on your operating system. For more information it is best to refer to the user's manual of your operating system.

(Note: All pictures used on the following pages are from the Windows XP OS.)
The Power Sources

The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack at the rear of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the AC/DC adapter (see sidebar if you are using the optional Port Replicator).
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an electrical outlet is unavailable. Battery life varies depending on the applications and the configuration you're using. To increase battery life, let the battery discharge completely before recharging (see “How do I completely discharge the battery?” on page 3 - 12).

We recommend that you do not remove the battery. For more information on the battery, please refer to “Battery Information” on page 3 - 9.
Turning on the Computer

Now you are ready to begin using your computer. To turn it on simply press the power button on the front panel.

When the computer is on, you can use the power button as a Standby/Hibernate/Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and holding the power button for longer than this will shut the computer down). Use Power Options in the Windows control panel to configure this feature.

Forced Off

If the system “hangs”, and the Ctrl + Alt + Del key combination doesn’t work, press the power button for 4 seconds, or longer, to force the system to turn itself off.

Power Button as Standby or Hibernate Button

If you are using a fully ACPI-compliant OS, (such as Windows XP) you can use the OS’s “Power Options” control panel to set the power button to send the system into Standby or Hibernate mode (see your OS’s documentation, or “Configuring the Power Button” on page 3 - 8 for details).
Power Management

Power Schemes

You can set your computer to conserve power through individual components by means of Power Schemes. You can also adjust the settings for each scheme to set the monitor to turn off after a specified time, and the computer's hard disk motor to turn off if the hard disk drive has not been accessed for a specified period of time (if the system reads or writes data, the hard disk motor will be turned back on). The schemes may also be set to set a specified time for the system to enter Standby or Hibernate modes (see “System Power Options” on page 3-6).

Figure 3-1
Power Schemes
Each *Windows Power Scheme* will also adjust the processor performance of your machine in order to save power. This is worth bearing in mind if you are experiencing any reduced performance (especially under DC/battery power).

Choose the **Home/Office Desk** scheme for maximum performance when the computer is powered from an AC power source. Choose the **Max Battery** scheme (bear in mind that this scheme may slow down the overall performance of the computer in order to save power) for maximum power saving when the computer is battery (DC power) powered. *Windows* will use **Portable/Laptop** as the default scheme.

*Windows* will use **Portable/Laptop** as the default scheme.
System Power Options

You can use the system power options to stop the computer’s operation and restart where you left off. This system features Standby and Hibernate sleep mode levels (Hibernate mode will need to be enabled by clicking the option in the Hibernate tab in the Power Options control panel - Figure 3 - 2 on page 3 - 7).

Hibernate Mode vs. Shutdown

Hibernate mode and Shutdown are the same in that the system is off and you need to press the power button to turn it on. Their main difference is:

When you come back from hibernation, you can return to where you last left off (what was on your desktop) without reopening the application(s) and file(s) you last used.

You can use either method depending on your needs.

Standby Mode vs. Hibernate Mode

If you want to stay away from your work for just a while, you can put the system on standby instead of in hibernation. It takes a longer time to wake up the system from Hibernate mode than from Standby mode.
Standby
Standby saves the least amount of power, but takes the shortest time to return to full operation. During Standby the hard disk is turned off, and the CPU is made to idle at its slowest speed. All open applications are retained in memory. When you are not using your computer for a certain length of time, which you specify in the operating system, it will enter Standby mode to save power.

Hibernate
Hibernate uses no power and saves all of your information on a part of the HDD before it turns the system off. Although it saves the most power it takes the longest time to return to full operation. You can set your computer to automatically enter Hibernate mode when the battery power is almost depleted. You will need to enable Hibernate mode from the Hibernate tab in the Power Options control panel. The system will resume from Hibernate mode by pressing the power button.

System Resume
The system can resume from Standby mode by:
- Pressing the power button
- Pressing the Sleep/Resume key combination
- An incoming call received on the modem (if enabled)
- Network card (Wake On LAN) activity if enabled

Figure 3 - 2
Enable Hibernation
Configuring the Power Button

The power button may be set to send the computer into either Standby or Hibernate mode (Figure 3 - 3). In Standby mode, the LED will blink green. In Hibernate mode the LED will be off. If you are in a power saving mode set to save power through individual components (e.g. hard disk, monitor), the LED will remain green.

You may also configure the Sleep/Resume key combination (Fn + F4) from the menu illustrated in Figure 3 - 3. In Windows this is referred to as the Sleep button.
Battery Information

Please follow these simple guidelines to get the best use out of your battery.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ” on page 3 - 12 for instructions on how to do this).

Battery Life
Your computer’s battery life is dependent upon many factors, including the programs you are running, and peripheral devices attached. Power Options (you may set low battery Alarms and actions, and check the Power Meter from the Power Options control panel), and settings in the OS will help prolong the battery life if configured appropriately.

Low Battery Warning
When the battery is critically low, immediately connect the AC/DC adapter to the computer or save your work, otherwise, the unsaved data will be lost when the power is depleted.

Figure 3 - 4
Power Options (Alarm & Power Meter)
Battery life may be shortened through improper maintenance. To optimize the life and improve its performance, fully discharge and recharge the battery at least once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to remove the battery for any reason see “Removing the Battery” on page 6 - 3.

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and plugged into an electrical outlet. If the computer is powered on, and in use, it will take several hours to fully recharge the battery. When the computer is turned off but plugged into an electrical outlet, battery charge time is less. (Refer to “LED Indicators” on page 1 - 9 for information on the battery charge status, and to “Battery Information” on page 3 - 9 for more information on how to maintain and properly recharge the battery pack.)
Proper handling of the Battery Pack
- DO NOT disassemble the battery pack under any circumstances
- DO NOT expose the battery to fire or high temperatures, it may explode
- DO NOT connect the metal terminals (+, -) to each other

Damaged Battery Warning
Should you notice any physical defects (e.g. the battery is bent out of shape after being dropped), or any unusual smells emanating from the notebook battery, shut your computer down immediately and contact your service center. If the battery has been dropped we do not recommend using it any further, as even if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly result in fire. It is recommended that you replace your computer battery every two years.
Battery FAQ

How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t turn off the computer by yourself even when you see a message that indicates the battery is critically low, just let the computer use up all of the battery power and shut down on its own. Disable the Power Options functions in the Control Panel, especially any Alarms (unclick the tickboxes - see 3 - 9) and Schemes (change all the settings to Never - see page 3 - 4). As the battery nears the end of its life save and close any critical files.

How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after about 20 partial discharges.
Chapter 4: Drivers & Utilities

This chapter deals with installing the drivers and utilities essential to the operation or improvement of some of the computer’s subsystems. The system takes advantage of some newer hardware components for which the latest versions of most available operating systems haven’t built in drivers and utilities. Thus, some of the system components won’t be auto-configured with an appropriate driver or utility during operating system installation. Instead, you need to manually install some system-required drivers and utilities. The following operating systems are supported.

- Windows XP Professional and Home Editions
- Windows XP Media Center Edition

What to Install

The Device Drivers & Utilities + User’s Manual CD-ROM contains the drivers and utilities necessary for the proper operation of the computer. (The Wireless LAN, optional Bluetooth, optional PC Camera and optional TV Tuner module drivers are on separate CD-ROMs supplied.) Table 4 - 1, on page 4 - 6 lists what you need to install manually according to your choice of the operating system, and it is very important that the drivers are installed in the order indicated.

Module Driver Installation

The procedures for installing drivers for the Wireless LAN, Bluetooth, PC Camera and TV Tuner modules are provided in “Modules & Options” on page 7 - 1. Make sure that the drivers are installed in the order indicated in Table 4 - 1, on page 4 - 6.
Navigate (Browse..) to D:

You will notice that many of the instructions for driver installation require you to "Navigate (Browse) to D:". We assume that you will install all drivers and utilities from the built-in CD device and it is assigned to "Drive D:". (In addition, all file extensions can be seen.)

In this case "D:" is the drive specified for your CD device. Not all computers are setup the same way, and some computers have the CD listed under a different drive letter - e.g. if you have two hard drives (or hard disk partitions) one may be designated as "Drive C:" and the other as "Drive D:". In this case the CD device may be designated as "Drive E:" - Please make sure you are actually navigating to the correct drive letter for the CD device.

When you click the Browse (button) after clicking Run in the Start menu you will see the "Look in:" dialog box at the top of the Browse window. Click the scroll button to navigate to My Computer to display the devices and drive letters.

Figure 4 - 1 - Navigate (Browse..) to..
Service Packs
Check the warnings on the following pages regarding installation of the appropriate Service Pack for your Windows OS. Make sure you have installed the appropriate Service Pack before installing all the drivers.

Service Pack Installed
To see which Service Pack is currently installed on your computer go to the General tab of the System control panel. Right-click the My Computer icon on the desktop or in the Start menu and select Properties. The Service Pack currently installed on your system will be listed under the "System:" heading. (If no Service Pack information is listed, then no Service Pack is installed.)

Windows XP Service Pack 2
Make sure you install Windows XP Service Pack 2 (or a Windows XP version which includes Service Pack 2) before installing any drivers. Service Pack 2 includes support for USB 2.0.
If you have upgraded the system by installing Service Pack 2 (i.e. your Windows XP version does not include Service Pack 2) then follow these instructions:
1. Click Start (menu), point to Settings and click Control Panel (or click Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click the Hardware (tab) > Device Manager (button).
4. Click "+" next to Other Devices (if its sub-items are not shown).
5. Right-click Universal Serial Bus (USB) Controller and select Uninstall > OK (if you don’t see the item then there is no need to take any further action).
6. Restart the computer and it will find the USB 2.0 controller.
Drivers & Utilities

Authorized Driver Message
If you receive a message telling you that the driver you are installing is not authorized (Digital Signature Not Found), just click Yes or Continue Anyway to ignore the message and continue the installation procedure.

You will receive this message in cases where the driver has been released after the version of Windows you are currently using. All the drivers provided will have already received certification for Windows.

Version Conflict Message
During driver installation if you encounter any “file version conflict” message, please click Yes to choose to keep the existing (newer) version.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it may be necessary to uninstall the original driver. To do this go to the Control Panel in the Windows OS and double-click the Add/Remove Programs item. If you see the individual driver listed (if not see below), uninstall it, following the on screen prompts (it may be necessary to restart the computer). Go to the appropriate section of the manual to complete the update/reinstall procedure for the driver in question.

If the driver is not listed in the Add/Remove Programs item:
1. Click Start (menu), point to Settings and click Control Panel (or click Start > Control Panel).
2. Double-click System (icon); System (icon) is in Performance and Maintenance (category).
3. Click Hardware (tab) > Device Manager (button).
4. Double-click the device you wish to update/reinstall the driver for (you may need to click “+”).
5. Look for the Update Driver button (check the Driver tab) and follow the on screen prompts.
Driver Installation

Insert the Device Drivers & Utilities + User’s Manual CD-ROM and the NoteBook Driver Installation application will run automatically. If you want to install the driver manually see “Manual Driver Installation” below.

NoteBook Driver Installation Application
1. Check the driver installation order from Table 4-1, on page 4-6 (the drivers must be installed in this order).
2. Double-click the name of the driver you wish to install.
3. Follow the instructions as listed in this chapter.
4. Make a note of the drivers you have installed.
5. If the computer needs to restart after installing a driver, you will usually need to click the “Yes/Finish” button when prompted to restart the computer.
6. To get back to the NoteBook Driver Installation screen click Start (menu) > Run... and navigate (Browse..) to D:\AUTODR3P.EXE and click OK.

Manual Driver Installation
If you wish to install the drivers manually, click the Exit button to quit the NoteBook Driver Installation application, then follow the manual installation procedure for each driver. The manual installation procedure begins with instructions on how to browse to the executable file; “Click Start (menu) > Run..”.

Figure 4-2 - NoteBook Driver Installation
### Drivers & Utilities

<table>
<thead>
<tr>
<th>WinXP SP2 Driver</th>
<th>Page #</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install the appropriate Service Pack for WinXP</td>
<td>Page 4 - 3</td>
</tr>
<tr>
<td>Chipset</td>
<td>Page 4 - 7</td>
</tr>
<tr>
<td>Video (VGA)</td>
<td>Page 4 - 7</td>
</tr>
<tr>
<td>Audio</td>
<td>Page 4 - 8</td>
</tr>
<tr>
<td>Modem</td>
<td>Page 4 - 8</td>
</tr>
<tr>
<td>LAN</td>
<td>Page 4 - 9</td>
</tr>
<tr>
<td>AP-Key Buttons</td>
<td>Page 4 - 9</td>
</tr>
<tr>
<td>TouchPad</td>
<td>Page 4 - 10</td>
</tr>
<tr>
<td>PCMCIA</td>
<td>Page 4 - 10</td>
</tr>
<tr>
<td>AutoMail</td>
<td>Page 4 - 11</td>
</tr>
<tr>
<td>Intel Wireless LAN</td>
<td>Page 7 - 3</td>
</tr>
<tr>
<td>Bluetooth</td>
<td>Page 7 - 4</td>
</tr>
<tr>
<td>PC Camera</td>
<td>Page 7 - 9</td>
</tr>
<tr>
<td>TV Tuner Module Options</td>
<td>Page 7 - 14</td>
</tr>
</tbody>
</table>

*Table 4 - 1 - Driver Installation*

### Driver Installation Procedure

This section covers driver and utility installation instructions for *Windows XP Home & Professional* (with Service Pack 2 installed).

### New Hardware Found

If you see the message “New Hardware Found” (*Found New Hardware Wizard*) during the installation procedure (other than when outlined in the driver install procedure), click **Cancel** to close the window, and follow the installation procedure as directed.

### Service Pack Installation

Make sure you install the appropriate service pack for your operating system before installing any drivers (see “Windows XP Service Pack 2” on page 4 - 3).
**Chipset**
1. Double-click **Chipset** from the Notebook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to 
   D:\Drivers\00Chipset\Setup.exe and click **OK**.
2. Click **Next > Yes > Next**.
3. Click **Finish** to restart the computer.

**Video(VGA)**
1. Double-click **VIDEO** from the Notebook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to (one of the following)
   D:\Drivers\01Vga\ATIM26\Setup.exe 
   D:\Drivers\01Vga\ATIM28\Setup.exe and click **OK**.
2. To continue click **Next > Yes > Express**
   (click **Continue Anyway/Yes** if asked if you want to continue at any time).
3. Click **Finish** to restart the computer.
Drivers & Utilities

Audio
1. Double-click **Audio** from the Notebook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to **D:\Drivers\02Audio\Setup.exe** and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart the computer.
4. When the computer restarts click **Cancel** if the **The Found New Hardware Wizard** appears (click Continue Anyway if asked if you want to continue at any time).
5. Click **Yes** to restart the computer (click **Cancel** if **The Found New Hardware Wizard** appears after restart).

Modem
1. Double-click **Modem** from the Notebook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (Browse..) to (one of the following) **D:\Drivers\03Modem\Conexant\Setup.exe**
   **D:\Drivers\03Modem\SmartLnk\Setup.exe**
   **D:\Drivers\03Modem\Setup.exe**
   and click **OK**.
2. Click **OK > OK** (click Continue Anyway if asked if you want to continue at any time).
3. The modem is ready for dial-up configuration.

Modem Country Selection

Be sure to check if the modem country selection is appropriate for you (Control Panel > Phone and Modem Options).
LAN
1. Double-click **LAN** from the NoteBook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to (one of the following)
   D:\Drivers\04Lan\Marvell\SetupYukon-Win.exe
   D:\Drivers\04Lan\Realtek\Setup.exe
   and click **OK**.
2. Click **Next**.
3. Click “**I accept the terms in the license agreement**” and click **Next > Next > Install**.
4. Click **Finish**.
5. The network settings can now be configured.

AP-Key Buttons
1. Double-click **AP-key** from the NoteBook Driver Installation menu.
   OR
   Click **Start** (menu) > **Run...** and navigate (**Browse..**) to (one of the following)
   D:\Drivers\05Ap-key\Setup.exe
   D:\Drivers\05Ap-key\AKsetup.exe
   and click **OK**.
2. Click **Next**.
3. Click **Finish** to restart your computer.
Drivers & Utilities

TouchPad
1. Double-click **Touchpad** from the Notebook Driver Installation menu.
   **OR**
   Click **Start** (menu) > **Run**... and navigate (Browse...) to
   D:\Drivers\06Touchpad\SETUP.EXE and click **OK**.
2. Click **Next** > **Next** (click **Continue Anyway** if asked if you want to continue at any time).
3. Click **Finish** to restart your computer.
4. You may then configure your TouchPad as outlined in “**TouchPad and Buttons/Mouse**” on page 2 - 11.

PCMCIA/Card Reader
1. Double-click **PCMCIA** from the Notebook Driver Installation menu.
   **OR**
   Click **Start** (menu) > **Run**... and navigate (Browse...) to
   D:\Drivers\07PCMCIA\setup.exe and click **OK**.
2. Click **Next** > **Yes** > **Finish**.

---

4 - 10 Driver Installation
AutoMail
1. Double-click AutoMail from the Notebook Driver Installation menu.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to D:\Drivers\11Automail\SETUP.EXE and click OK.
2. To continue click Next > Next > Finish.
3. For further details see “Auto Mail Checker” on page 2 - 8.

Module Drivers
See the following pages for the driver installation procedures for any modules included in your purchase option.

Wireless LAN
See the introduction in “Intel PRO/Wireless Mini-PCI WLAN Module” on page 7 - 2, and check the installation procedure.

Bluetooth
See the installation procedure in “Bluetooth Module” on page 7 - 4.

PC Camera
See the installation procedure in “PC Camera Module” on page 7 - 8.

TV Tuner Options
See the installation procedure in “Installing the LifeView FlyDVB-T Driver” on page 7 - 15, or “Installing the MPC622 Driver for Windows XP Media Center Edition (MCE)” on page 7 - 16.
Drivers & Utilities
Chapter 5: BIOS Utilities

Overview

This chapter gives a brief introduction to the computer’s built-in software:

Diagnostics: The POST (Power-On Self Test)

Configuration: The Setup utility

If your computer has never been set up, or you are making important changes to the system (e.g. hard disk setup), then you should review this chapter first and note the original settings found in Setup. Even if you are a beginner, keep a record of the settings you find and any changes you make. This information could be useful if your system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you are doing. Many of the settings are required by the system, and changing them could cause it to become unstable or worse. If you have any doubts, consult your service representative.
The Power-On Self Test (POST)

Each time you turn on the computer, the system takes a few seconds to conduct a POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there is a problem that prevents the system from booting, it will display a system summary and prompt you to run Setup.

If there are no problems, the Setup prompt will disappear and the system will load the operating system. Once that starts, you can’t get into Setup without rebooting.
Failing the POST

Errors can be detected during the POST. There are two categories, “fatal” and “non-fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong with your system. Take the computer to your service representative or authorized service center as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the problem (make a note of this message!) followed by the prompt:

• Press <F1> to resume
• <F2> to enter Setup

Press F1 to see if the boot process can continue. It may work, without the correct configuration.

Press F2 to run the Setup program and try to correct the problem. If you still get an error message after you change the setting, or if the “cure” seems even worse, call for help.
The Setup Program

The Phoenix Setup program tells the system how to configure itself and manage basic features and subsystems (e.g. port configuration).

Entering Setup

To enter Setup, turn on the computer and press F2 during the POST. The prompt (Press F2 to Enter Setup) seen in Figure 5 - 1 is usually present for a few seconds after you turn on the system. If you get a “Keyboard Error”, (usually because you pressed F2 too quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and then hold down F2 when prompted. The Setup main menu will appear.
Setup Screens
The following pages contain additional advice on portions of the Setup.

Along the top of the screen is a menu bar with five (5) menu headings. When you select a heading, a new screen appears. Scroll through the features listed on each screen to make changes to Setup.

Instructions on how to navigate each screen are in the box along the bottom of the screen. If these tools are confusing, press F1 to call up a General Help screen, then use the arrow keys to scroll up or down the page.

The Item Specific Help on the right side of each screen explains the highlighted item and has useful messages about its options.

If you see an arrow ► next to an item, press Enter to go to a sub-menu on that subject. The sub-menu screen that appears has a similar layout, but the Enter key may execute a command.
System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you can change the date and time settings in your operating system, you will also change these settings. Some applications may also alter data files to reflect these changes.
**IDE Channel 0 Master/Slave (Main Menu)**
Pressing **Enter** opens the sub-menu to show the configuration of either a CD Device or HDD that on the computer’s IDE Channel 0. Use the **Auto** (Type:) setting to have the items configured automatically for you.

**SATA Port 1(Main Menu)**
Pressing **Enter** here opens the sub-menu to show the configuration of any hard disks on the computer’s SATA Port 1. Use the **Auto** (Type:) setting to have the item configured automatically for you.

**System/Extended Memory: (Main Menu)**
This item contains information on the system memory, and is not user configurable. The system will auto detect the amount of memory installed.

**VGA BIOS Revision: (Main Menu)**
This item contains information on the Video BIOS version, including the amount of video memory available. This information is not user configurable.
Advanced Menu

Advanced Chipset Control (Advanced Menu)
Pressing Enter here will provide valuable information on your system’s Advanced Chipset Control features. The sub-menu items allow you to configure advanced settings which affect the power and processor management of the computer. Unless you are an advanced user, these options are best configured in your Windows OS. In addition you can enable/disable the Giga LAN PXE OPROM for network boot.
National 383 SIO Control Sub-Menu (Advanced Menu)
Pressing Enter here will provide a sub-menu that controls the configuration of National 383 SIO devices such as the serial port, and/or the infrared transceiver (FIR Device).

Legacy USB Support (Advanced Menu)
Use this menu item to enable/disable the support for Legacy Universal Serial Bus. Legacy USB support allows USB devices (usually those which don’t require drivers) to be used in operating systems other than Windows (e.g. DOS).

Boot-time Diagnostic Screen: (Advanced Menu)
Use this menu item to enable/disable the display on the boot-time Diagnostic Screen (Note that enabling this option will bypass the POST as illustrated in Figure 5 - 1 on page 5 - 2).

Reset Configuration Data: (Advanced Menu)
This item is set to No as default. You can change the setting to Yes if you have installed a new add-on which has reconfigured the system, resulting in such a serious system conflict that the operating system is unable to boot.

Power on Boot Beep/Battery Low Alarm Beep: (Advanced Menu)
Enable/Disable the audible warning for power and battery low alarm here.
Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Setup utility. This will not affect access to the computer OS, (only the Setup utility) unless you choose to set a Password on Boot (see over).

Security Menu
The changes you make here affect the access to the Setup utility itself, and also access to your machine as it boots up after you turn it on. These settings do not affect your machine or network passwords which will be set in your software OS.
Password on boot: (Security Menu)
Specify whether or not a password (supervisor or user password) should be entered to boot the computer. If “Enabled” is selected, only users who enter a correct password can boot the system (see the warning in the sidebar). The default setting is “Disabled”.

Note: To clear existing passwords press Enter and type the existing password, then press Enter for the new password (without typing any password entry) and Enter again to confirm the password clearance.

Fixed disk boot sector: (Security Menu)
If you choose “Write Protect” this will protect against viruses being written to the hard disk boot sector (this is not a substitute for installing an anti-virus program - see “Viruses” on page 8 - 4).
When you turn the computer on it will look for an operating system (e.g. Windows XP) from the devices listed in this menu, and in this priority order. If it cannot find the operating system on that device, it will try to load it from the next device in the order specified in the Boot priority order. Item specific help on the right is available to help you move devices up and down the order. Boot devices usually are hard drives, floppy drives, and CD-ROMs/DVD-ROMs and Networks (LANs).
When you specify a device as a boot device on the Boot Menu, it requires the availability of an operating system on that device. Most home computers come with an operating system already installed on “Drive C:”.

If you wish to boot from a CD-ROM/DVD-ROM you will need to add it to the boot order. As a general rule the order below is recommended:

1. Removable Devices (usually floppy disks)
2. CD-ROM/DVD-ROM Drive
3. Hard Drive
4. LAN

In everyday use you will usually boot from the hard drive, however there may be occasions when it is advantageous to boot from a floppy disk or CD-ROM/DVD-ROM.

**Network (LAN) Boot**

To boot from a network, see “Configuring the Network Boot Protocol” on page 5 - 14.
Configuring the Network Boot Protocol

1. Enable the Giga LAN PXE OPROM option from the Advanced > Advanced Chipset Control menu, and then configure the settings at startup. When you see the message pictured 1, press and hold the Shift and F10 keys. Configure the network protocol. Save the settings to automatically boot from the network.

2. At startup, press and hold the Shift and F10 keys. Configure the network protocol. Save the settings to automatically boot from the network.
Choosing to **Discard Changes**, or **Exit Discarding Changes**, will wipe out any changes you have made to the **Setup**. You can also choose to restore the original **Setup** defaults that will return the **Setup** to its original state, and erase any previous changes you have made in a previous session.
Chapter 6: Upgrading The Computer

Overview

This chapter contains information on upgrading the computer. Follow the steps outlined to make the desired upgrades. If you have any trouble or problems you can contact your service representative for further help. Before you begin you will need:

- A small crosshead or Phillips screwdriver
- A small regular slotted (flathead) screwdriver
- An antistatic wrist strap

Before working with the internal components you will need to wear an antistatic wrist strap to ground yourself because static electricity may damage the components. The chapter includes:

- Removing the Battery
- Upgrading the Hard Disk Drive
- Upgrading the Optical (CD/DVD) Device
- Upgrading the System Memory (RAM)
- Inserting the 2nd Hard Disk

Please make sure that you review each procedure before you perform it.
When Not to Upgrade

These procedures involve opening the system’s case, adding and sometimes replacing parts.

You should **not** perform any of these upgrades if:

- Your system is still under warranty or a service contract
- You don’t have all the necessary equipment
- You’re not in the correct environment
- You doubt your abilities

Under any of these conditions, contact your service representative to purchase or replace the component(s).

---

**Power Safety Warning**

Before you undertake any upgrade procedures, make sure that you have turned off the power, and disconnected all peripherals and cables (including telephone lines). It is advisable to also remove your battery in order to prevent accidentally turning the machine on.

---

**Removal Warning**

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and screw(s) before turning the computer on.
Removing the Battery

If you are confident in undertaking upgrade procedures yourself, for safety reasons it is best to remove the battery.

1. Turn the computer off, and turn it over.
2. Slide the latch 1 in the direction of the arrow, and hold it in place.
3. Lift the battery out at point 2, in the direction of the arrow 3.

Warranty Warning
Please check with your service representative before undertaking any upgrade procedures to find out if this will VOID your warranty.

Figure 6 - 1
Battery Latch
Upgrading the Hard Disk Drive

The hard disk drive can be taken out to accommodate other 2.5" serial (SATA) hard disk drives with a height of 9.5mm (h) (see “Storage” on page C - 4). Follow your operating system’s installation instructions, and install all necessary drivers and utilities (as outlined in “Driver Installation” on page 4 - 5), when setting up a new hard disk.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the hard disk bay cover and remove screws 1 - 5 Model A OR screws 1 - 11 Model B.

HDD System Warning

New HDD’s are blank. Before you begin make sure:
You have backed up any data you want to keep from your old HDD.
You have all the CD-ROMs and FDDs required to install your operating system and programs.
If you have access to the internet, download the latest application and hardware driver updates for the operating system you plan to install. Copy these to a removable medium.

Figure 6 - 2
Bay Screws & Covers
For **Model A** computers (*see overleaf for Model B)*:

3. Remove screws 12 - 14 from the hard disk assembly.
4. Pull the tab upward and lift the assembly 15 out of the computer.
5. Remove the 4 screws 16 - 19 to release the hard disk from the assembly cover, and remove the connector 20.
6. Reverse the process to install any new hard disk.
For **Model B** computers:

7. Remove screws 22 & 23 from the hard disk assembly.
8. Pull the tab upward and lift the assembly 24 out of the computer.
9. Remove the 4 screws 25 - 28 to release the hard disk from the assembly cover.
10. Reverse the process to install any new hard disk.

---

**Figure 6-4**
HDD & Case Assembly Removal
(Model B Computers Only)
Upgrading the Optical (CD/DVD) Device

1. Turn off the computer, and turn it over and remove the battery.
2. Slide the latch 1 in the direction of the arrow, and hold it in place.
3. Eject the optical device by carefully sliding the latch 2 in the direction of the arrow.
4. Reverse the process to install the new device.

Figure 6 - 5
Removing the Optical CD/DVD Device
Upgrading the System Memory (RAM)

The computer has two memory sockets for 200 pin Small Outline Dual In-line (SO-DIMM) DDRII (DDR2) type memory modules (see “Memory” on page C - 2 for details of supported module types). The total memory size is automatically detected by the POST routine once you turn on your computer.

1. Turn off the computer, and turn it over and remove the battery.
2. Locate the bay cover and remove screws 1 - 5 Model A, OR screws 1 - 11 Model B.

Figure 6 - 6
Bay Screws & Covers
3. Gently pull the two release latches on the sides of the memory socket in the direction indicated by the arrows (12 & 13) in Figure 6 - 7.

4. The RAM module will pop-up, and you can remove it.

Contact Warning
Be careful not to touch the metal pins on the module’s connecting edge. Even the cleanest hands have oils which can attract particles, and degrade the module’s performance.
5. Pull the latches to release the second module if necessary.
6. Insert a new module holding it at about a 30° angle and fit the connectors firmly into the memory slot.
7. The module’s pin alignment will allow it to only fit one way. Make sure the module is seated as far into the slot as it will go. DO NOT FORCE the module; it should fit without much pressure.
8. Press the module in and down towards the mainboard until the slot levers click into place to secure the module.
9. Replace the memory socket cover and the screw.
10. Restart the computer to allow the BIOS to register the new memory configuration as it starts up.
**Inserting the 2nd Hard Disk**

1. Turn off the computer, and turn it over and remove the battery.
2. Slide the latch 1 in the direction of the arrow, and hold it in place.
3. Eject the installed device (CD/DVD, battery or HDD) by carefully sliding the latch 2 in the direction of the arrow.
4. **Turn the computer over again, so that the top of the computer is facing upwards.**
5. Insert the new hard disk until the lock clicks firmly back in place.

Note that the procedure pictured is for **Model B computers**, however the procedure for **Model A** is identical.

**Figure 6 - 9**
2nd HDD Insertion

**Inserting the 2nd Hard Disk**
Firstly turn the computer over to remove the battery and eject the device currently installed in the bay.

It is very important to turn the computer back over again (so that the top cover is facing up) before inserting the 2nd HDD assembly. This will ensure the connectors make proper contact. Do not force the device in, it will only fit one way.
Upgrading the Processor

If you want to upgrade your computer by replacing the existing processor with a faster/new one you will need to contact your customer service representative. We recommend that you do not do this yourself, since if it is done incorrectly you may damage the processor or mainboard.

Warranty
The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Unauthorized tampering with the HDD may also violate your warranty.
Chapter 7: Modules & Options

Overview

This chapter contains the information on the WLAN, Bluetooth, PC Camera and TV Tuner modules which may come with your computer, depending on the configuration purchased. If you are unsure please contact your service representative.

The chapter includes information on the following:

- Intel PRO/Wireless Mini-PCI WLAN Module
- Bluetooth Module
- PC Camera Module
- TV Tuner Module Options

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.
Modules & Options

Intel PRO/Wireless Mini-PCI WLAN Module

If you have included an Intel PRO/Wireless 2915ABG (802.11a/b/g) Mini-PCI WLAN module in your purchase option, you will have the appropriate software CD provided for your module.

Before installing the Intel PRO/Wireless 2915ABG Mini-PCI WLAN driver, make sure that the Wireless LAN module is on (the LED will be green). Use the **Fn + F11 key combination** (see “Function Keys” on page 1 - 11) to toggle power to the Wireless LAN module (make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6).

To get help on the network settings you can view the User Guide from the Intel PRO CD-ROM.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the **Fn + F11** key combination to toggle power to the optional WLAN module, and check the indicator to see if the module(s) is powered on or not (see Table 1 - 2, on page 1 - 9 Table 1 - 4, on page 1 - 11).

Figure 7 - 1
Installation Screen

7 - 2 Intel PRO/Wireless Mini-PCI WLAN Module
Intel WLAN Driver Installation

1. Make sure the module is powered on, then insert the Intel PROSet/ Wireless CD-ROM into the CD/DVD drive.
2. Click Install Software (button).
3. Click the button to accept the license and click Next > Next > OK.
4. Click OK to complete the installation.
5. You can configure the settings by going to the Intel (R) PROSet Wireless control panel (Start > Programs/All Programs > Intel PROSet Wireless), or by double-clicking the taskbar icon 📲.

User Guide
You can view the User Guides by inserting the Intel PROSet/ Wireless CD-ROM and clicking View User Guides (button) as per “Installation Screen” on page 7 - 2.

Figure 7 - 2
Intel PROSet/ Wireless
Bluetooth Module

If you have included an Bluetooth module in your purchase option, you will have the appropriate software CD provided for your module.

Before installing the Bluetooth driver, make sure that the optional Bluetooth module is on (the LED will be green). Use the Fn + F12 key combination (see “Function Keys” on page 1 - 11) to toggle power to the Bluetooth module. Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.

Bluetooth Driver Installation

1. Make sure the module is powered on, then insert the Bluetooth CD-ROM into the CD/DVD drive.
2. The program will run automatically.
3. Click Application/Driver Installation (button).
4. The computer will restart automatically.
5. You can configure the settings by going to the IVT Corporation BlueSoleil - Main Window control panel (Start > Programs/All Programs > IVT BlueSoleil > BlueSoleil), or by clicking the taskbar icon 🟥.

Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibited. Make sure the module(s) are OFF if you are using the computer aboard aircraft.

Use the Fn + F12 key combination to toggle power to the optional Bluetooth module, and check the indicator to see if the module(s) is powered on or not (see Table 1 - 2, on page 1 - 9/ Table 1 - 4, on page 1 - 11).
Send To Bluetooth
Right-Click to select any file and scroll down to Send To ... Bluetooth Device.

User Guide
View the BlueSoleil User Guides from the Help Menu (or press the F1 key) in the IVT Corporation BlueSoleil - Main Window control panel. Click BlueSoleil User Guides in the Contents tab, and click to select the appropriate User Guide from the panel on the right.

Figure 7 - 3
Bluetooth Control Panel & User Guides
Bluetooth Audio Setup

If you wish to use Bluetooth audio devices, it is necessary to setup the audio recording options in Windows (see Figure 7 - 4 on page 7 - 7).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Device volume tab.
3. Click Options, scroll down and click Properties.
4. Select Bluetooth AV/HS Audio from the Mixer device menu.
5. Click OK and close the windows.

To Reset the Audio for Realtek Audio Recording:
1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Device volume tab.
3. Click Options, scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Click Recording (radio button) and the volume controls tickboxes should appear.
6. Click OK and close the windows.
Figure 7 - 4
Bluetooth Audio Setup
(Windows XP)

Click to make volume controls appear.
PC Camera Module

If you have included an **PC Camera** module in your purchase option, you will have the appropriate software CD provided for your module.

Before installing the **PC Camera** driver, make sure that the optional PC Camera is on (the \emph{\textit{LED}} will be green). Use the \textit{Fn + F10} key combination (see \textit{“Function Keys” on page 1 - 11}) to toggle power to the PC Camera module. Make sure you install the drivers in the order indicated in \textit{Table 4 - 1, on page 4 - 6}.

After installing the driver you can run the application software by going to the **BisonCam** item in the **Start > Programs/All Programs** menu and selecting the **BisonCap** program.

**Taking Still Pictures**

Double-click the **My Computer** icon on the desktop, or go to the **Start** menu and point to **My Computer**, then click it.

Double-click the **BisonCam, NB Pro** icon.

Click **Take a new picture** in the **Camera Tasks** box.

**Latest PC Camera Driver Information**

Check the **PC Camera CD**, and any accompanying insert pages, for the latest updated information on the PC Camera driver, which may override the information provided here.
Sertek PC Camera Driver Installation (WinXP)

1. Press the **Fn + F10** key combination to power on the PC Camera module (click **Cancel** if you see a “New Hardware Found” message).
2. Insert the **PC Camera CD-ROM** into the CD/DVD drive.
3. The program will run automatically.
4. Click **Install Products**.
5. Choose the language you prefer and click **OK**.
6. Click **Next** (click **Continue Anyway** if asked if you want to continue).
7. When the **Found New Hardware Wizard** appears click the **No, not this time** button, and click **Next**.
8. Select **install the software automatically (Recommended)** and click **Next** (click **Continue Anyway** if asked if you want to continue).
9. Click **Finish** (in the **Found New Hardware Wizard**) > **Finish** (in the **InstallShield Wizard**) to restart the computer.
10. Run the **BisonCap** application program from the shortcut on the desktop, or from the **BisonCam** item in the **Start > Programs/All Programs** menu (if the hardware is turned off use the **Fn + F10** key combination to turn it on again).
PC Camera Audio Setup

If you wish to capture video & audio with your camera, it is necessary to setup the audio recording options in Windows (see Figure 7 - 5 on page 7 - 11).

1. Go to the Start menu and point to Settings (or just click Control Panel) and click Control Panel, then double-click the Sounds & Audio Devices icon (Sounds, Speech, and Audio Devices in Category View).
2. Click Advanced in the Device volume tab.
3. Click Options, scroll down and click Properties.
4. Select Realtek HD Audio input from the Mixer device menu.
5. Click Mic Volume (check box) if it is not checked, then click OK.
6. Make sure the Select (check box) in the Recording Control panel, under the Mic Volume section, is checked (boost the volume as high as it will go).
7. Click OK and close the windows.
8. Run the BisonCap application program from the Start > Programs/All Programs > BisonCam menu.
9. Go to the Devices menu heading and select Realtek HD Audio input (it should have a tick alongside it).
10. Go to the Capture menu heading and select Capture Audio (it should have a tick alongside it).
Figure 7-5
PC Camera Audio Setup (Windows XP)
BisonCap

BisonCap is a video viewer useful for general purpose video viewing and testing, and can capture video files to .avi format.

1. Run the BisonCap program from the Start > Programs/All Programs > BisonCam menu (it is recommended that you set the capture file before the capture process - see Set Capture File below).
2. Go to the Capture menu heading (if you wish to capture audio check “PC Camera Audio Setup” on page 7 - 10) and select Start Capture.
3. On the first run of the program (if you have not set the captured file) you will be asked to choose a file name and size (see the sidebar - Pre-Allocating File Space) for the captured file.
4. Click OK to start capturing the video, and press Esc to stop the capture.
5. If you wish to, you may go to the File menu and select Save Captured Video As..., choose a file name and location, then click Open (you can view the file using the Windows Media Player).

Set Capture File

You will only be asked to set the capture file name on the first run of the BisonCap program. When you run the program the next time the file will automatically be overwritten with the newly captured file. To avoid overwriting files you can go to the Set Capture File.. option in the File menu, and set the file name and location before capture. Set the name and location then click Open (you can choose Cancel to ignore the file size if prompted).

Pre-Allocating File Space

You may pre-allocate the file size for the capture file in the BisonCap program. You can choose to ignore this by clicking Cancel.

Pre-allocating space on the hard disk can improve the capture quality (particularly of large capture files), by reducing the amount of work the hard disk has to do in finding space for the video data as it is being captured.

You may find it helpful to defragment the HDD before capture.
Eliminating Screen Flicker

If you find that the video screen in the BisonCap program is flickering, you can try to adjust the setting in the Video Capture Filter options.

1. Run the BisonCap program.
2. Go to Options and scroll down to select “Video Capture Filter...”.
3. Click either 50Hz or 60Hz under Frequency in Property Page (tab).

![Video Capture Filter](image)
TV Tuner Module Options

You may have one of two possible optional Mini-PCI TV Tuner modules supplied with your computer, depending on your purchase configuration. The optional TV Tuner allows you to watch TV, play music CDs, video conference and capture still images and video on your PC.

The LifeView FlyDVB-T Hybrid (for both analog and digital inputs) Mini-PCI TV Tuner Module comes with a remote control unit, and CDs containing the AverTV Utility software & InterVideo WinDVD 4 software.

The YUAN PVR MPC622-MCE TV Tuner module comes with a remote control unit, and a CD containing driver software for Windows XP Media Center Edition.

The CATV-In jack will only be enabled when the TV Tuner module is installed. Make sure you install any software before connecting the coaxial cable to the TV antenna input.

TV Antenna

The TV antenna supplied with any TV Tuner module is intended for indoor use only. Please do not use your TV Tuner module outdoors.
LifeView FlyDVB-T Hybrid Mini-PCI TV Tuner Module

If your purchase includes the LifeView FlyDVB-T Hybrid Mini-PCI TV Tuner Module, then install the driver and application as per the instructions below.

Installing the LifeView FlyDVB-T Driver
1. Insert the driver CD-ROM into the CD/DVD drive.
2. Double-click LifeView DTV and Driver.
3. Choose the language you prefer, and click OK.
4. Click Next > Next.
5. Click Finish to restart the computer.
6. Run the program from the Start > Programs/All Programs > LifeView and select the LifeView DTV program, or double-click the icon on the desktop.

Installing the InterVideo WinDVD 4 Software
1. Insert the InterVideo WinDVD CD-ROM into the CD/DVD drive.
2. Click Next > Yes.
3. Type in the serial number and click Next >........ Next.
4. Click Finish.
5. Run the program from the Start > Programs/All Programs > InterVideo WinDVD 4 menu, and select the InterVideo WinDVD 4 program, or double-click the icon on the desktop.
YUAN PVR Mini-PCI MPC622-MCE TV Tuner Module

If your purchase includes the YUAN PVR MPC622-MCE TV Tuner for Windows XP Media Center Edition, then you will need to install the driver as per the instructions below. In order to watch TV channels you will need to purchase a copy of Cyberlink Power DVD 5.0.

Installing the MPC622 Driver for Windows XP Media Center Edition (MCE)

1. Insert the driver CD-ROM into the CD/DVD drive.
2. The CD will autorun, OR
   click Start (menu) > Run... and navigate (Browse..) to D:\MPC622_WHQL.exe and click OK.
3. Click Next > Finish.
4. To watch TV you will then need to install a copy of Cyberlink Power DVD 5.0.
Chapter 8: Troubleshooting

Overview

Should you have any problems with your computer, before consulting your service representative, you may want to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface. If all else fails, talk to your service representative. You should also make a record of what happened and what remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call your service representative.
Basic Hints and Tips

Many of the following may seem obvious but they are often the solution to a problem when your computer appears not to be working.

- **Power** - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indicators” on page 1 - 9) to see the computer’s power status.

- **Connections** - Check all the cables to make sure that there are no loose connections anywhere.

- **Power Savings** - Make sure that the system is not in Hibernate or Standby mode by pressing the keys configured in your Power Options (see “Configuring the Power Button” on page 3 - 8), the Fn + F4 key combination, or power button to wake-up the system.

- **Brightness** - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the brightness.

- **Display Choice** - Press Fn + F7 to make sure the system is not set to “external only” display.

- **Boot Drive** - Make sure there are no floppy disks in any connected drive when you start up your machine (this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / “Remove disks or other media. Press any key to restart”).
Backup and General Maintenance

• Always **backup** your important data, and keep copies of your OS and programs safe, but close to hand. Don’t forget to note the **serial numbers** if you are storing them out of their original cases, e.g. in a CD wallet.

• Run **maintenance programs** on your hard disk and OS as often as you can. You may schedule these programs to run at times when you are not using your computer. You can use those that are provided free with your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if you choose to use a **Supervisor** password for the BIOS (see “Security Menu” on page 5 - 10).

• Keep copies of vital **settings files** such as network, dialup settings, mail settings etc.(even if just brief notes).

---

**Warranty**

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your warranty.
Troubleshooting

Viruses

• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm your computer and cause you to lose data. Anti-Virus programs are commercially available and the definitions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-mail attachments so take care when opening any attached file. You can configure most Anti-Virus programs to check all e-mail attachments. Note: You should also beware of files from people you know as the virus may have infected an address book and been automatically forwarded without the person’s knowledge.

• Keep a “Boot Floppy Disk” or “Bootable CD-ROM” (this disk provides basic information which allows you to startup your computer) handy. You may refer to your OS’s documentation for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at least instructions on how to make one).
Troubleshooting

Upgrading and Adding New Hardware/Software

• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s manual, but what about any new peripheral devices you have just purchased? Many problems are caused by the installation of new hardware and/or software. Always refer to the documentation of any new hardware and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are usually available to download from vendor’s websites).
Troubleshooting

• Thoroughly check any recent changes you made to your system as these changes may affect one or more system components, or software programs. If possible, go back and undo the change you just made and see if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may be found; Example - if your computer has many devices plugged into its ports, and a number of programs running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and removing devices and restarting where necessary) will often find the source of a problem, although this may be time consuming.
## Troubleshooting

### Problems and Solutions

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
</table>
| You turned on the power but it doesn’t work.                          | *Battery missing / incorrectly installed.* Check the battery bay, make sure the battery is present and seated properly (the design of the battery only allows it to go in one way). Make sure there’s nothing interfering with the battery contacts.  
*The Audio "DJ" player is on.* Press the Audio "DJ" power button to turn the player off, then press the computer’s power button to power on the computer. |
| The battery LED power indicator is blinking orange.                   | *Low Battery.* Plug in the DC power source. If the computer doesn’t start up immediately, turn it off then on again.                                    |
| You are losing battery power too quickly.                             | *The system is using too much power.* If your OS has a *Power Options* scheme (see “Power Schemes” on page 3 - 4) check its settings. You may also be using a PC Card device that is drawing a lot of power. |
| Actual battery operating time is shorter than expected.               | *The battery has not been fully discharged before being recharged.* Make sure the battery is fully discharged and recharge it completely before reusing (see “Battery Information” on page 3 - 9).  
*Power Options have been disabled.* Go to the **Control Panel** in *Windows* and re-enable the options.  
*A peripheral device or PC Card is consuming a lot of power.* Turn off the unused device to save power. |
## Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The computer feels too hot.</td>
<td>Make sure the computer is properly ventilated and the Vent/Fan intakes are not blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see “Overheating” on page 1-14). Make sure you’re using the correct adapter. Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a notebook which is powered on in a travel bag may cause the Vent/Fan intakes to be blocked.</td>
</tr>
<tr>
<td>Nothing appears on screen.</td>
<td>The system is in a power saving mode. Toggle the sleep/resume key combination, ( F_n + F_4 ) (see “Sleep Button” on page 3-8). The screen controls need to be adjusted. Toggle the screen control key combinations ( F_n + F_8/F_9 ). If you’re connected to an external monitor, make sure it’s plugged in and turned on. You should also check the monitor’s own brightness and contrast controls. The computer is set for a different display. Toggle the screen display key combination, ( F_n + F_7 ). If an external monitor is connected, turn it on. The screen saver is activated. Press any key or touch the TouchPad.</td>
</tr>
</tbody>
</table>
## Troubleshooting

### Problem: No image appears on the external monitor I have plugged in and powered on.

You haven't installed the video driver and configured it appropriately from the Control Panel. See “ATI Video Driver Controls” on page B - 1 for instructions on installing and configuring the video driver.

### Problem: You forget the boot password.

If you forget the password, you may have to discharge the battery of the CMOS. Contact your service representative for help.

### Problem: The sound cannot be heard or the volume is very low.

The volume might be set too low. Check the volume control in the Volume Control Panel in the Windows taskbar, or use the key combination Fn + F5 and F6 (see “Audio Features” on page 2 - 12) to adjust.

### Problem: The compact disc cannot be read.

The compact disc is dirty. Clean it with a CD-ROM cleaner kit.

### Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
### Troubleshooting

<table>
<thead>
<tr>
<th>Problem</th>
<th>Possible Cause - Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>The compact disc tray will not open when there is a disc in the tray.</td>
<td><em>The compact disc is not correctly placed in the tray. Gently try to remove the disc using the eject hole (see “Loading Discs” on page 2 - 3).</em></td>
</tr>
<tr>
<td>The DVD regional codes can no longer be changed.</td>
<td><em>The code has been changed the maximum 5 times. See “DVD Regional Codes” on page 2 - 5.</em></td>
</tr>
<tr>
<td>The Audio “DJ” CD Player will not turn on (nothing appears on the LCD of the player).</td>
<td><em>The computer is turned ON (see “System Map: Front View (Audio “DJ”)” on page 1 - 12). Check your computer is not turned on (or running in a power saving mode), and if it is, then shut it down and press the ON/OFF switch on the Audio “DJ” Player.</em></td>
</tr>
<tr>
<td>Unwelcome numbers appear when typing.</td>
<td><em>If the LED is lit, then Num Lock is turned ON. (see “LED Indicators” on page 1 - 9).</em></td>
</tr>
<tr>
<td>The system freezes or the screen goes dark.</td>
<td><em>The system’s power saving features have timed-out. Use the AC/DC adapter, press the sleep (Fn + F4) key combination, or press the power button if no LEDs are lit.</em></td>
</tr>
<tr>
<td>The system never goes into a power saving mode.</td>
<td><em>Power Options features are not enabled. Go to the Windows Power Options menu and enable the features you prefer (see “System Power Options” on page 3 - 6). Make sure you have enabled Hibernate mode from the control panel.</em></td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be detected.</td>
<td><em>The modules are off. Check the appropriate LED indicator to see if the WLAN/Bluetooth/PC Camera module is on or off (see “LED Indicators” on page 1 - 9). If the LED indicator is off, then press the Fn + F11 (WLAN), Fn + F12 (Bluetooth) or Fn + F10 (PC Camera) key combination(s) in order to enable the modules (see “Function Keys” on page 1 - 11).</em></td>
</tr>
<tr>
<td>Problem</td>
<td>Possible Cause - Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>The Wireless LAN/Bluetooth/PC Camera modules cannot be configured.</td>
<td>The driver(s) for the module(s) have not been installed. Make sure you have installed the driver for the appropriate module (see the instructions for the appropriate module in “Modules &amp; Options” on page 7 - 1).</td>
</tr>
</tbody>
</table>
Troubleshooting
Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer to communicate with external devices, connect to the internet etc.
## Notebook Ports and Jacks

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Built-In Microphone</td>
<td>The built-in microphone allows you to record on your computer</td>
</tr>
<tr>
<td>Card Reader Port</td>
<td>The card reader allows you to use some of the latest digital storage cards. Push the card into the slot and it will appear as a removable device.</td>
</tr>
<tr>
<td>CATV-In Jack</td>
<td>Use this jack to connect a CATV cable if you have included the optional Mini-PCI TV Tuner in your purchase.</td>
</tr>
<tr>
<td>DVI-Out Port</td>
<td>The DVI-Out (Digital Visual Interface) Port allows you to connect an external monitor, or Flat Panel Display, to allow dual video or simultaneous display on the LCD and external monitor/FPD. If you are using an older type of monitor you will need to use a converter to convert the signal from DVI to VGA.</td>
</tr>
<tr>
<td>DC-In Jack</td>
<td>Plug the supplied AC/DC adapter into this jack to power your computer.</td>
</tr>
<tr>
<td>Headphone-Out Jack</td>
<td>Headphones or speakers may be connected through this jack. Note: Set your system’s volume to a reduced level before connecting to this jack.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line-In Jack</td>
<td>The Line-In jack allows you to play audio sources through the computer’s speakers.</td>
</tr>
<tr>
<td>Microphone-In Jack</td>
<td>Plug an external microphone in to this jack to record on your computer.</td>
</tr>
<tr>
<td>Mini-IEEE 1394 Port</td>
<td>This port allows a high-speed connection to various peripheral devices, e.g. external disk drives and digital cameras (see note below).</td>
</tr>
</tbody>
</table>

**Mini-IEEE 1394a Port**

The Mini-IEEE 1394 port only supports **SELF POWERED IEEE 1394a devices**.

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>RJ-11 Phone Jack</td>
<td>This port connects to the built-in modem. You may plug the telephone line directly into this RJ-11 telephone connection. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
<tr>
<td>RJ-45 LAN Jack</td>
<td>This port supports LAN (Network) functions. <strong>Note:</strong> Broadband (e.g. ADSL) modems usually connect to the LAN port.</td>
</tr>
</tbody>
</table>
## Interface (Ports & Jacks)

<table>
<thead>
<tr>
<th>Item</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Security Lock Slot</td>
<td>To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be purchased at any computer store.</td>
</tr>
<tr>
<td>Serial Port</td>
<td>Connect a serial type mouse to this port.</td>
</tr>
<tr>
<td>S/PDIF-Out Jack</td>
<td>This S/PDIF (Sony/Philips Digital Interface Format) Out Jack allows you to connect your DVD-capable PC to a Dolby AC-3 compatible receiver for “5.1” or ‘dts’ surround sound.</td>
</tr>
<tr>
<td>S-Video-Out Jack</td>
<td>Connect your television to your computer and view DVDs, VCDs or anything else your computer can display. You will need an S-Video cable to make the connection. Enable this jack from the video driver controls.</td>
</tr>
<tr>
<td>USB 2.0/1.1 Ports</td>
<td>These USB 2.0 compatible ports (USB 2.0 is fully USB 1.1 compliant) are for low-speed peripherals such as keyboards, mice or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the computer, without the need to turn the system off (if the power rating of your USB device is 500mA or above, make sure you use the power supply which comes with the device).</td>
</tr>
</tbody>
</table>
Appendix B: ATI Video Driver Controls

The basic settings for configuring the LCD are outlined in “Video Features” on page 1 - 19.

ATI Video Driver Installation

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 6.

1. Double-click VIDEO from the Notebook Driver Installation menu.
   OR
   Click Start (menu) > Run... and navigate (Browse..) to (one of the following)
   D:\Drivers\01Vga\ATIM26\Setup.exe
   D:\Drivers\01Vga\ATIM28\Setup.exe
   and click OK.

2. To continue click Next > Yes > Express (click Continue Anyway/Yes if asked if you want to continue at any time).

3. Click Finish to restart the computer.
ATI Video Driver Controls

ATI Mobility Radeon Properties

More advanced video configuration options are provided in the **ATI Mobility Radeon X700/X800 XT Properties** control panel:

1. Open the **Display Properties** (see “Video Features” on page 1 - 19) control panel.
2. Click **Advanced** (button).
3. Click the **ATI Mobility Radeon Properties** tabs (see the examples in Figure B - 2) to adjust video settings. (See the sidebar for information on the ATI taskbar icon menus.)

**Figure B - 1**
ATI Menus (taskbar Icon)

---

**ATI Taskbar Icon**

You can also access ATI Mobility Radeon X700/X800 XT Properties by right-clicking the ATI icon in the taskbar. Point to Settings and click **ATI Display Settings**, then click **Settings** (tab).

The menus (Figure B - 1) will also allow access to Help, Troubleshooting and Schemes etc.
Help Menus

Right-click on almost any item in the tabs to bring up the “What’s This?” button. Click the “What’s This?” button to bring up the help menu.

PowerPlay Menu

The menus pictured in this chapter are from the ATI Mobility Radeon X700. The X800 XT has an additional PowerPlay menu with power saving features.

Figure B - 2
ATI Mobility Radeon Properties

Help Menu
**Display Devices**

Besides the built-in LCD, you can also use an external monitor/flat panel display or TV as your display device. The following are the display options:

1. The built-in LCD.
2. An external monitor connected to the DVI-Out port (may require DVI to VGA converter).
3. A flat panel display connected to the DVI-Out port (may require DVI to VGA converter).
4. A TV (Model B computers with ATI Mobility Radeon X800 XT video cards also support HDTV, but require an HDTV converter*) connected to the S-Video-Out port.

*Note: Contact your service center for the HDTV converter.

---

**Theater Mode**

Theater Mode can be enabled by clicking **Theater Mode Options** (button) in the **Overlay** tab from the ATI Mobility Radeon Properties. (see Figure B - 2). Theater Mode enables you to display video playback in full screen on a secondary monitor.

Theater Mode is not supported if you have the TV Tuner module installed.

---

**Monitor and TV Tuner**

If you are connecting both a monitor/flat panel display to the DVI-Out port, and a cable/aerial to the optional TV Tuner module, **make sure you attach the cable/aerial to the TV Tuner first**, then the monitor.
Attaching Other Displays

If you prefer to use a monitor or flat panel display, connect it to the DVI-Out Port at the rear of the computer.

1. Attach your external monitor to the DVI-Out port (or TV to the S-Video-Out port), and turn it on.
2. Select the Displays tab in ATI Mobility Radeon Properties.
3. Click the enable/disable button for the display device you wish to use.
4. Click Apply.
5. Click Yes to accept the settings and OK to save the changes.

6. Select One display as Primary, the remaining as the Clone (the Clone may operate in either Clone Mode, or Extended Desktop Mode).

Function Key Combination

You can use the \texttt{Fn + F7} key combination to toggle through the display options:

- Notebook Only
- External Display Only
- Notebook + External Display

Make sure you give the displays enough time to refresh.

Figure B - 3
Display Settings
## Display Modes

### Single
Only one of your displays is used.

### Multiple - Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content and each display device can be configured independently.

### Multiple - Extended Desktop Mode
Extended Desktop mode treats both connected displays as separate devices, and they act as a virtual desktop resulting in a large workspace. When enabled, you can drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the displays, and a different program visible in the other display.

### Primary & Clone Displays

- **Primary** display in an Extended Desktop environment will be associated with display Icon 1 in the settings tab.

- **Clone** display will set the associated display to show a copy of the Primary desktop.

- **Clone** display in an Extended Desktop environment will show the portion of the desktop extended from the Primary display.

---

### B - 6 Display Modes
Clone Mode
Clone Mode simply shows an exact copy of the Primary display desktop on the other display(s). This mode will drive multiple displays with the same content. Use this feature to display the screen through a projector for a presentation. Each display device can be configured independently as this allows you to set the options for overhead projectors etc., which require specific resolutions and refresh rates. Click on the bar of the device in question to bring up the configuration options.

Display Data Channel Information
Click the "Use DDC Information" button to disable/enable DDC.

DDC is a data channel used by newer monitors to provide information (e.g. maximum resolution and refresh rates) to the video adapter.

Different monitors support different resolutions and refresh rates (experiment for the best setting).

Figure B - 4
Monitor Properties
Extended Desktop Mode

The system supports **Extended Desktop** in multiple display environments in *Windows XP*. An Extended Desktop creates a desktop spanning multiple displays and acts as a large workspace.

To get this effect:

1. Attach your external monitor to the DVI-Out port (or TV to the S-Video Out port), and turn it on.
2. Select the **Displays** tab in the **ATI Mobility Radeon Properties**.
3. Click the **enable/disable button** for the display device you wish to use.
4. Click **Apply**.
5. Click **Yes** to accept the settings and **OK** to save the changes.
6. Use the **Display Properties** (see “**Extended Desktop Monitor Arrangement** on page B - 9) window to select the second monitor by clicking on the icon, or select it from the “**Display:**” pop-up menu.
7. Click “**Extend my Windows desktop onto this monitor.**”.
8. Click **Apply > OK**.
9. Use the **Display Properties** control panel to drag the monitors to match the physical arrangement you wish to use.
10. In the example shown in *Figure B - 5* the primary monitor is on the left, the other display is on the right.

11. When **Extended Desktop Mode** is enabled, drag any icons or windows across to the other display desktop. It is therefore possible to have one program visible in one of the monitors, and a different program visible in the other monitor.
12. One display will be set to Primary. The displays may be switched as long as one is set to Primary.

**Figure B - 6**
Displays Tab (Extended Desktop Mode)

In this picture the notebook LCD panel is the primary display, and the desktop may be extended to any attached displays.

13. To switch from Extended Desktop mode back to Clone mode, first uncheck the tick box to disable the Extended Desktop (via the settings tab in the Display Properties control panel - Figure B - 5) and click Apply.

14. Repeat the procedure in “Attaching Other Displays” on page B - 5 (make sure you have selected the appropriate display to get all the ATI Mobility Radeon Properties options tabs) to return to Clone mode (click the button to enable any displays if necessary).

B - 10 Display Modes
Enabling TV Display

To display desktop images on a TV, connect the TV to your computer by using an S-Video cable from the TV to the S-Video-Out jack at the rear of the computer (see “System Map: Rear View” on page 1 - 14).

Further help is available to help you troubleshoot your TV connection through the menus accessed from the taskbar (see page Figure B - 1 on page B - 2).
The TV Properties tabs allow you to adjust the TV settings and TV Format etc.
Appendix C: Specifications

Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/speeds and CD/DVD device types) may be changed or updated due to the manufacturer's release schedule. Check with your service center for details.
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Processor</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Celeron</strong> Chen</td>
<td><strong>Specifications</strong></td>
</tr>
<tr>
<td><strong>Processors are</strong></td>
<td><strong>Available for</strong></td>
</tr>
<tr>
<td><strong>Model A Computers</strong></td>
<td><strong>Only:</strong></td>
</tr>
<tr>
<td><strong>Computers Only:</strong></td>
<td></td>
</tr>
<tr>
<td>Intel Pentium® M</td>
<td>(478-pin) Micro-FC-PGA Package</td>
</tr>
<tr>
<td>Processor</td>
<td>Models 730/ 740/ 750/ 760/ 770/ 780</td>
</tr>
<tr>
<td></td>
<td>(µ0.09) 0.09 Micron Process Technology</td>
</tr>
<tr>
<td></td>
<td>2MB On-die L2 Cache &amp; 533MHz FSB</td>
</tr>
<tr>
<td>Intel Celeron® M</td>
<td>(478-pin) Micro-FCPGA Package</td>
</tr>
<tr>
<td>Processor</td>
<td>Models 350/ 350J/ 360/ 360J/ 370/ 380/ 390</td>
</tr>
<tr>
<td></td>
<td>(µ0.09) 0.09 Micron Process Technology</td>
</tr>
<tr>
<td></td>
<td>1MB On-die L2 Cache &amp; 400MHz FSB</td>
</tr>
<tr>
<td>Core Logic</td>
<td>Intel 915PM + ICH6-M</td>
</tr>
<tr>
<td>Memory</td>
<td>Two 200 Pin SO-DIMM Sockets Supporting <strong>DDRII</strong></td>
</tr>
<tr>
<td></td>
<td><strong>(DDR2)</strong> With Speeds Up To <strong>533</strong> MHz</td>
</tr>
<tr>
<td></td>
<td>Memory Expandable up to <strong>2GB</strong> (256/ 512/ 1024 MB)<strong>DDRII</strong> Modules)</td>
</tr>
<tr>
<td></td>
<td>(Note: Do Not Use Other Module Types)</td>
</tr>
<tr>
<td>Security</td>
<td>Security (Kensington® Type) Lock Slot BIOS Password</td>
</tr>
<tr>
<td>BIOS</td>
<td>One 4MB Flash ROM Phoenix™ BIOS, Plug and Play</td>
</tr>
<tr>
<td>LCD</td>
<td></td>
</tr>
<tr>
<td><strong>Model A Computers:</strong></td>
<td>15.4&quot; WXGA (1440*900) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>15.4&quot; WSXGA+ (1680*1050) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>15.4&quot; WUXGA (1920*1200) Flat Panel TFT</td>
</tr>
<tr>
<td><strong>Model B Computers:</strong></td>
<td>17.0&quot; WXGA (1440*900) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>17.0&quot; WSXGA+ (1680*1050) Flat Panel TFT OR</td>
</tr>
<tr>
<td></td>
<td>17.0&quot; WUXGA (1900*1200) Glare Type Flat Panel TFT</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>Video Card Options</td>
<td></td>
</tr>
<tr>
<td><strong>Model A Computers:</strong></td>
<td></td>
</tr>
<tr>
<td>ATI Mobility Radeon X700 (M26) PCI Express Video Card</td>
<td></td>
</tr>
<tr>
<td>128/256MB DDR Video RAM On Board</td>
<td></td>
</tr>
<tr>
<td>256-bit Video Memory Interface</td>
<td></td>
</tr>
<tr>
<td>PCI Express * 16</td>
<td></td>
</tr>
<tr>
<td>Fully Supports DirectX® 9</td>
<td></td>
</tr>
<tr>
<td><strong>Model B Computers:</strong></td>
<td></td>
</tr>
<tr>
<td>ATI Mobility Radeon X700 (M26) PCI Express Video Card</td>
<td></td>
</tr>
<tr>
<td>128MB DDR Video RAM On Board</td>
<td></td>
</tr>
<tr>
<td>256-bit Video Memory Interface</td>
<td></td>
</tr>
<tr>
<td>PCI Express * 16</td>
<td></td>
</tr>
<tr>
<td>Fully Supports DirectX® 9</td>
<td></td>
</tr>
<tr>
<td>OR</td>
<td></td>
</tr>
<tr>
<td>ATI Mobility Radeon X800 XT (M28 PRO) PCI Express Video Card</td>
<td></td>
</tr>
<tr>
<td>256MB DDR-III (DDR3) Video RAM On Board</td>
<td></td>
</tr>
<tr>
<td>256-bit Video Memory Interface</td>
<td></td>
</tr>
<tr>
<td>PCI Express * 16</td>
<td></td>
</tr>
<tr>
<td>Fully Supports DirectX® 9</td>
<td></td>
</tr>
<tr>
<td>HDTV Output Support</td>
<td></td>
</tr>
</tbody>
</table>
## Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Storage</strong></td>
<td><strong>One Changeable 12.7mm(h) Optical Device (CD/DVD) Type Drive</strong> (see “Optional” on page C - 7 for drive options) in Removable Bay</td>
</tr>
<tr>
<td></td>
<td><strong>One Removable Bay for 2nd Battery or 2nd PATA Hard Disk Drive or Optical Disk Drive</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Easy Changeable 2.5” 9.5 mm (h) Hard Disk Drive Supporting ATA 100/ 66/ 33 or SATA 150</strong></td>
</tr>
<tr>
<td></td>
<td><strong>The System Supports both PATA (Parallel) and SATA (Serial) Interfaces</strong></td>
</tr>
<tr>
<td><strong>Audio</strong></td>
<td><strong>7.1 Channel High Definition Audio Chipset (AZALIA) with UAA (Universal Audio Architecture)</strong></td>
</tr>
<tr>
<td></td>
<td><strong>EAX™ 1.0 &amp; 2.0 Compatible</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Direct Sound 3D™ Compatible</strong></td>
</tr>
<tr>
<td></td>
<td><strong>A3D™ Compatible</strong></td>
</tr>
<tr>
<td></td>
<td><strong>16/ 20/ 24-bit S/PDIF-Out Supporting 44.1KHz/ 48KHz/ 96KHz Sample Rate</strong></td>
</tr>
<tr>
<td></td>
<td><strong>2 * Built-In Hi-Fi Speakers</strong></td>
</tr>
<tr>
<td></td>
<td><strong>Built-In Standalone Audio &quot;DJ&quot; CD Player (Supports MP3 Formats)</strong></td>
</tr>
<tr>
<td></td>
<td><strong>SRS WOW Surround Sound (SRS/ TruSurround/ TruBass / Focus Enhancement)</strong> - (Supplied as a standard feature for Model B computers, and as a factory option for Model A computers)</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Interface &amp; Communication</strong></td>
<td>Four USB 2.0 Ports&lt;br&gt;One Mini-IEEE 1394 Port&lt;br&gt;One DVI-Out Port&lt;br&gt;One Microphone-In Jack&lt;br&gt;One Line-In Jack&lt;br&gt;One Headphone-Out Jack&lt;br&gt;One S/PDIF Output Jack&lt;br&gt;One Serial Port&lt;br&gt;One S-Video-Out Jack&lt;br&gt;300K Pixel PC Video Camera Module with USB Interface <em>(Factory Option)</em>&lt;br&gt;<strong>OR</strong>&lt;br&gt;1.3M Pixel PC Video Camera Module with USB Interface <em>(Factory Option)</em>&lt;br&gt;Bluetooth 1.2 Module with USB Interface <em>(Optional)</em>&lt;br&gt;<strong>Wireless Network Options</strong>&lt;br&gt;Intel PRO/Wireless 2915ABG (802.11a/b/g) <em>(Optional)</em>&lt;br&gt;One RJ-11 Jack for Plug &amp; Play Fax/Modem&lt;br&gt;AZALIA 56K Plug &amp; Play Fax/Modem V.90/92 Compliant&lt;br&gt;One RJ-45 Jack (Local Area Network)&lt;br&gt;10MB/100MB/1Gbit PCI-Express&lt;br&gt;Fast Ethernet On Board&lt;br&gt;One Infrared Transceiver IrDA 1.1 Compliant (IrDA 1.1/ FIR/ SIR/ ASKIR)&lt;br&gt;Infrared Transfer 1cm ~ 30 cm Operating Distance&lt;br&gt;115.2K bps SIR&lt;br&gt;4M bps FIR&lt;br&gt;One CATV-In Jack (Functions with Optional TV Tuner Module)&lt;br&gt;One Consumer Infrared (CIR) Transceiver for TV Remote (Functions with Optional TV Tuner Module)&lt;br&gt;</td>
</tr>
</tbody>
</table>
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Keyboard &amp; Pointing Device</strong></td>
<td>Winkey Keyboard</td>
</tr>
<tr>
<td></td>
<td>Built-In TouchPad with Scrolling Function</td>
</tr>
<tr>
<td><strong>PCMCIA</strong></td>
<td>One Type-II PCMCIA CardBus PC Card Slot</td>
</tr>
<tr>
<td><strong>Power Management</strong></td>
<td>Supports ACPI 2.0</td>
</tr>
<tr>
<td></td>
<td>Supports Hibernate Mode</td>
</tr>
<tr>
<td></td>
<td>Supports Standby</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td><strong>Power Supply - Model A Computers:</strong></td>
</tr>
<tr>
<td></td>
<td>Full Range AC/DC Adapter 20V, 4.5A (90 Watts), 100<del>240V, 47</del>63Hz</td>
</tr>
<tr>
<td></td>
<td>Full Range AC/DC Adapter 20V, 6.0A (120 Watts), 100<del>240V, 47</del>63Hz</td>
</tr>
<tr>
<td></td>
<td>8 Cell Smart Lithium-Ion Battery Pack, 4.4AH</td>
</tr>
<tr>
<td></td>
<td>2nd <strong>Optional</strong> Battery - 6 Cell Smart Lithium-Ion Battery Pack, 3.8AH</td>
</tr>
<tr>
<td><strong>Environmental Spec</strong></td>
<td>Temperature</td>
</tr>
<tr>
<td></td>
<td>Operating: 5°C ~ 35°C</td>
</tr>
<tr>
<td></td>
<td>Non-Operating: -20°C ~ 60°C</td>
</tr>
<tr>
<td></td>
<td>Relative Humidity</td>
</tr>
<tr>
<td></td>
<td>Operating: 20% ~ 80%</td>
</tr>
<tr>
<td></td>
<td>Non-Operating: 10% ~ 90%</td>
</tr>
<tr>
<td><strong>Physical Dimensions &amp; Weight</strong></td>
<td><strong>Model A Computers:</strong></td>
</tr>
<tr>
<td></td>
<td>360mm (w) * 287mm (d) * 26 - 39mm (h) Min 3.4 kg (+3%) With 8 Cell Battery &amp; Optical Device</td>
</tr>
<tr>
<td></td>
<td><strong>Model B Computers:</strong></td>
</tr>
<tr>
<td></td>
<td>397mm (w) * 293mm (d) * 22 - 44.9mm (h) 3.8 kg With 8 Cell Battery &amp; Optical Device</td>
</tr>
</tbody>
</table>

---

C - 6 Specifications
### Specifications

<table>
<thead>
<tr>
<th>Feature</th>
<th>Specification</th>
</tr>
</thead>
</table>
| Optional                      | **Optical Drive Module Options:**  
|                               | DVD/CD-RW Combo Drive Module                                                 |  
|                               | DVD-Dual Drive Module                                                        |  
|                               | 8 Cell Smart Lithium-Ion Battery Pack, 4.4AH                                |  
|                               | 300K Pixel PC Video Camera Module with USB Interface (*Factory Option*)      |  
|                               | OR                                                                            |  
|                               | 1.3M Pixel PC Video Camera Module with USB Interface (*Factory Option*)      |  
|                               | **Wireless Network Options**                                                 |  
|                               | Intel PRO/Wireless 2915ABG (802.11a/b/g) (*Optional*)                        |  
|                               | **OR**                                                                       |  
|                               | Bluetooth 1.2 Module with USB Interface                                      |  
|                               | USB Floppy Disk Drive                                                        |  
|                               | 2nd Battery - 6 Cell Smart Lithium-Ion Battery Pack, 3.8AH                   |  
|                               | 2nd PATA Hard Disk Drive                                                     |  
|                               | Mini-PCI Hybrid TV Tuner Card                                                |  
|                               | Mini-PCI MCE TV Tuner Card (Hardware Decoder)                                |  
|                               | Sonic Home Theater                                                           |  
|                               | Roxio 7.0 CD Burner Software                                                 |  
|                               | *Factory Option*                                                             |  
|                               | *(Optional)*                                                                 |  

---

**Specifications C - 7**
Specifications